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Introduction and Safety 1
In This Chapter The following topics are covered in this chapter:

Topic See Page

ABI PRISM® 3100-Avant Genetic Analyzer 1-2

To Get Started Quickly 1-2

Documentation 1-3

Safety 1-4
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ABI PRISM® 3100-Avant Genetic Analyzer

Definition The ABI PRISM® 3100-Avant Genetic Analyzer is an automated capillary 
electrophoresis system that can separate, detect, and analyze fluorescently labeled 
DNA fragments in one run.

System Components The 3100-Avant Genetic Analyzer system includes the following components:

♦ ABI PRISM® 3100-Avant Genetic Analyzer 

♦ Computer workstation with Microsoft® Windows NT operating system

♦ ABI PRISM® 3100-Avant Genetic Analyzer software

♦ ABI PRISM® DNA Sequencing Analysis and/or ABI PRISM® GeneScan® Analysis 
software 

♦ Capillary array 

♦ Reagent consumables

To Get Started Quickly

Important Safety
Information

Before using the instrument, read the safety information starting on page 1-4 and in 
the ABI PRISM® 3100 and 3100-Avant Genetic Analyzer Site Preparation and Safety 
Guide (P/N 4315835).

What You Should
Know

This manual is written for principle investigators and laboratory staff who are planning 
to operate and maintain a 3100-Avant Genetic Analyzer.

Before attempting the procedures in this manual, you should be familiar with the 
following topics:

♦ Windows NT operating system

♦ General techniques for handling DNA samples and preparing them for 
electrophoresis. Detailed information about preparing samples for sequencing 
and fragment analysis is given in other Applied Biosystems’ manuals (see the 
table below).

♦ Networking, which is needed if you want to integrate the 3100-Avant Genetic 
Analyzer into your existing laboratory data flow system
1-2 Introduction and Safety



                                                            
Documentation

List of User
Documents

The following table lists the complete ABI PRISM® 3100-Avant Genetic Analyzer 
document set for users:

About User Bulletins User bulletins inform you of technical information, product improvements, and related 
new products and laboratory techniques.

Applied Biosystems will mail user bulletins related to the use of this instrument to you. 
We recommend storing the bulletins in this manual. A tab labeled “User Bulletins” has 
been included for this purpose.

Title Contents P/N

Instrument 

ABI PRISM® 3100 Genetic Analyzer 
and 3100-Avant Genetic Analyzer 
Site Preparation and Safety Guide

♦ Laboratory requirements for 
installation

♦ Instrument and chemical safety

4315835

ABI PRISM® 3100 Genetic Analyzer 
and 3100-Avant Genetic Analyzer 
User Reference Guide

♦ Theory of operations

♦ System management

♦ Troubleshooting

4335393

ABI PRISM® 3100-Avant Genetic 
Analyzer User Guide

User procedures for using and 
maintaining the instrument

4333549

Software

ABI PRISM® DNA Sequencing 
Analysis Software v. 3.7 NT User 
Guide

Detailed procedures for analyzing 
sequencing data 

4308924

ABI PRISM® GeneScan Analysis 
Software v. 3.7 NT User Guide

Detailed procedures for analyzing 
fragment analysis data 

4308923

Chemistry

ABI PRISM® 3100 Genetic Analyzer 
Sequencing Chemistry Guide

♦ Detailed chemistry procedures 
specific for the 3100 and 3100-Avant 
Genetic Analyzers

♦ Chemistry troubleshooting for the 
3100 and 3100-Avant Genetic 
Analyzers

4315831

ABI PRISM® Automated DNA 
Sequencing Chemistry Guide

♦ A description of DNA sequencing 
instruments, chemistries, and software

♦ Detailed procedures for preparing 
DNA templates, performing cycle 
sequencing, and preparing extension 
products

4305080
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Safety

Documentation User
Attention Words

Five user attention words appear in the text of all Applied Biosystems user 
documentation. Each word implies a particular level of observation or action as 
described below.

Note Calls attention to useful information.

IMPORTANT Indicates information that is necessary for proper instrument operation, accurate 
chemistry kit use, or safe use of a chemical.

Indicates a potentially hazardous situation which, if not avoided, may result in 
minor or moderate injury. It may also be used to alert against unsafe practices.

Indicates a potentially hazardous situation which, if not avoided, could result in 
death or serious injury.

Indicates an imminently hazardous situation which, if not avoided, will result in 
death or serious injury. This signal word is to be limited to the most extreme situations.

Chemical Hazard
Warning

CHEMICAL HAZARD. Some of the chemicals used with Applied Biosystems 
instruments and protocols are potentially hazardous and can cause injury, illness, or death.

♦ Read and understand the material safety data sheets (MSDSs) provided by the 
chemical manufacturer before you store, handle, or work with any chemicals or 
hazardous materials.

♦ Minimize contact with chemicals. Wear appropriate personal protective equipment 
when handling chemicals (e.g., safety glasses, gloves, or protective clothing). For 
additional safety guidelines, consult the MSDS.

♦ Minimize the inhalation of chemicals. Do not leave chemical containers open. Use 
only with adequate ventilation (e.g., fume hood). For additional safety guidelines, 
consult the MSDS.

♦ Check regularly for chemical leaks or spills. If a leak or spill occurs, follow the 
manufacturer’s cleanup procedures as recommended on the MSDS.

♦ Comply with all local, state/provincial, or national laws and regulations related to 
chemical storage, handling, and disposal.

\
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Chemical Waste
Hazard Warning

CHEMICAL WASTE HAZARD. Wastes produced by Applied Biosystems 
instruments are potentially hazardous and can cause injury, illness, or death.

♦ Read and understand the material safety data sheets (MSDSs) provided by the 
manufacturers of the chemicals in the waste container before you store, handle, or 
dispose of chemical waste.

♦ Handle chemical wastes in a fume hood.

♦ Minimize contact with chemicals. Wear appropriate personal protective equipment 
when handling chemicals (e.g., safety glasses, gloves, or protective clothing). For 
additional safety guidelines, consult the MSDS.

♦ Minimize the inhalation of chemicals. Do not leave chemical containers open. Use 
only with adequate ventilation (e.g., fume hood). For additional safety guidelines, 
consult the MSDS.

♦ After emptying the waste container, seal it with the cap provided.

♦ Dispose of the contents of the waste tray and waste bottle in accordance with 
good laboratory practices and local, state/provincial, or national environmental 
and health regulations.

Site Preparation and
Safety Guide

A site preparation and safety guide is a separate document sent to all customers who 
have purchased an Applied Biosystems instrument. Refer to the guide written for your 
instrument for information on site preparation, instrument safety, chemical safety, and 
waste profiles.

About MSDSs Some of the chemicals used with this instrument may be listed as hazardous by their 
manufacturer. When hazards exist, warnings are prominently displayed on the labels 
of all chemicals. 

Chemical manufacturers supply a current MSDS before or with shipments of 
hazardous chemicals to new customers and with the first shipment of a hazardous 
chemical after an MSDS update. MSDSs provide you with the safety information you 
need to store, handle, transport and dispose of the chemicals safely.

We strongly recommend that you replace the appropriate MSDS in your files each 
time you receive a new MSDS packaged with a hazardous chemical.

CHEMICAL HAZARD. Be sure to familiarize yourself with the MSDSs before 
using reagents or solvents.
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Ordering MSDSs You can order free additional copies of MSDSs for chemicals manufactured or 
distributed by Applied Biosystems using the contact information below.

For chemicals not manufactured or distributed by Applied Biosystems, call the 
chemical manufacturer.

To order documents by automated telephone service:

Step Action

1 From the U.S. or Canada, dial 1.800.487.6809.

2 Follow the voice instructions to order documents (for delivery by fax).

Note There is a limit of five documents per fax request.

To order documents by automated telephone service:

1 From the U.S. or Canada, dial 1.800.487.6809.

2 Follow the voice instructions to order documents (for delivery by fax).

Note There is a limit of five documents per fax request.

To order documents by automated telephone service:

Step Action

1 From the U.S. or Canada, dial 1.800.487.6809.

2 Follow the voice instructions to order documents (for delivery by fax).

Note There is a limit of five documents per fax request.

To obtain documents through the Applied Biosystems web site: 

Step Action

1 Go to http://www.appliedbiosystems.com

2 In the SEARCH field at the top of the page, type in the chemical of interest.

3 Select MSDS from the IN drop-down list to the right, then click GO.

4 When the Search Results page opens, find the document you want in the language 
of your choice and click on it to open a PDF of the document.
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Instrument Safety
Labels

Safety labels are located on the instrument. Each safety label has three parts:

♦ A signal word panel, which implies a particular level of observation or action (e.g., 
CAUTION or WARNING). If a safety label encompasses multiple hazards, the 
signal word corresponding to the greatest hazard is used.

♦ A message panel, which explains the hazard and any user action required.

♦ A safety alert symbol, which indicates a potential personal safety hazard. See the 
ABI PRISM® 3100 Genetic Analyzer and 3100-Avant Genetic Analyzer Site 
Preparation and Safety Guide for an explanation of all the safety alert symbols 
provided in several languages.

About Waste
Disposal

As the generator of potentially hazardous waste, it is your responsibility to perform the 
actions listed below.

♦ Characterize (by analysis if necessary) the waste generated by the particular 
applications, reagents, and substrates used in your laboratory.

♦ Ensure the health and safety of all personnel in your laboratory.

♦ Ensure that the instrument waste is stored, transferred, transported, and disposed 
of according to all local, state/provincial, or national regulations.

Note Radioactive or biohazardous materials may require special handling, and disposal 
limitations may apply.

Before Operating the
Instrument

Ensure that everyone involved with the operation of the instrument has:

♦ Received instruction in general safety practices for laboratories

♦ Received instruction in specific safety practices for the instrument

♦ Read and understood all related MSDSs

Avoid using this instrument in a manner not specified by Applied Biosystems. 
Although the instrument has been designed to protect the user, this protection can be impaired 
if the instrument is used improperly.

Computer
Workstation Safety

Correct ergonomic configuration of your computer workstation can prevent 
stress-producing effects such as fatigue, pain, and strain. Minimize or eliminate these 
effects on your body by designing your workstation to promote neutral or relaxed 
working positions.

MUSCULOSKELETAL AND REPETITIVE MOTION HAZARD. These hazards 
are caused by potential risk factors that include, but are not limited to, repetitive motion, 
awkward posture, forceful exertion, holding static unhealthy positions, contact pressure, and 
other workstation environmental factors.

♦ Use equipment that comfortably supports the user in neutral working positions 
and maintains adequate accessibility to the keyboard, monitor, and mouse.

♦ Position keyboard, mouse, and monitor to promote relaxed body and head 
postures.
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Electric Shock ELECTRICAL SHOCK HAZARD. To reduce the chance of electrical shock, do 
not remove covers that require tool access. No user serviceable parts are inside. Refer 
servicing to Applied Biosystems qualified service personnel.

Lifting/Moving PHYSICAL INJURY HAZARD. Do not attempt to lift the instrument or any 
other heavy objects unless you have received related training. Incorrect lifting can cause painful 
and sometimes permanent back injury. Use proper lifting techniques when lifting or moving the 
instrument. Two or three people are required to lift the instrument, depending upon instrument 
weight.

WARNING!

WARNING!
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Performing a Run 2
In This Chapter The following topics are covered in this chapter: 
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The following topics are covered in this chapter: (continued)

Topic See Page
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Section: Introduction

In This Section The following topics are covered in this section:

Topic See Page

Summary Flowchart 2-4

Planning Your Runs 2-5
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Summary Flowchart

Flowchart of a
Typical Run

This flowchart provides an overview of the steps required to perform a run on the 
ABI PRISM® 3100-Avant Genetic Analyzer.

Spatial calibration done?

Power on computer, then
power on instrument

Launch ABI PRISM 3100-Avant
Data Collection software and
view and set preferences

Set up instrument:
  • Prepare syringes
  • Install capillary array
  • Add/change polymer
  • Fill reservoirs

Prepare samples

Place plate on autosampler

Create plate record

Link plate to plate record

Start and monitor run

View and archive data

Perform calibration

Display and check calibration
Don't know

Yes No

Spectral calibration done?

Perform calibration

Display and check calibration
Don't know

Yes No

Need to set active
spectral calibration?

Set active spectral calibration

Yes No

G
R

21
49
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Planning Your Runs

Decisions to Make The main decisions you will need to make when preparing for a run are listed below.

Decision Table  

Decision Comments

Analysis application Either: 

♦ ABI PRISM® GeneScan® Analysis Software for fragment 
analysis

♦ ABI PRISM® DNA Sequencing Analysis Software for DNA 
sequencing 

Type of polymer Either:

♦ ABI PRISM® 3100 POP-4™ polymer for fragment analysis, long 
read sequencing or ultra rapid sequencing

♦ ABI PRISM® 3100 POP-6™ polymer for standard sequencing or 
rapid sequencing 

Length of capillary 
array

Either:

♦ 22-cm capillary array for microsatellites and SNP genotyping

♦ 36-cm capillary array for microsatellites, SNP genotyping, rapid 
sequencing or ultra rapid sequencing

♦ 50-cm capillary array for standard sequencing

♦ 80-cm capillary array for long read sequencing

Type of plate Either a:

♦ 96-well plate

♦ 384-well plate 

Method of creating 
plate records

There are six different ways to create plate records.

Analysis module Either:

♦ Select one of the supplied analysis modules

♦ Create your own analysis module

Run module Either:

♦ Select one of the supplied run modules

♦ Edit one of the supplied run modules to change the conditions 
used for a run

Number of times to run 
your samples

To run your samples only once, use only one run module column 
and one analysis module column when creating the plate record. 

To run each sample up to five times, use the same or different run 
module columns and the same or different analysis module 
columns.

Single or batch run Either:

♦ A single run that electrophoreses up to four samples

♦ A batch run that performs several sequential runs without 
needing operator attention
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Where to save data Data are saved as ABIF sample files. Sample files can be stored 
locally or on a network. The storage location is defined in the 
Preferences or the default location:

D:\AppliedBio\3100-Avant\Data Extractor

Spatial calibration A spatial calibration must be performed after each time you:

♦ Install or replace a capillary array

♦ Temporarily remove the capillary array from the detection block

Spectral calibration A spectral calibration must be performed:

♦ Whenever you use a new dye set on the instrument

♦ After the laser or CCD camera has been realigned/replaced by 
a service engineer

♦ If you begin to see a decrease in spectral separation (pull-up 
and/or pull-down peaks)

♦ For fragment analysis only, if you change capillary array 
lengths

Decision Table (continued)

Decision Comments
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Section: Starting the 3100-Avant System

In This Section The following topics are covered in this section:

Topic See Page

Starting the Computer 2-8

Starting the Instrument 2-9

Starting the 3100-Avant Data Collection Software 2-10

Setting Software Preferences 2-12
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Starting the Computer

Starting the
Computer

Workstation

IMPORTANT You must start the computer workstation before starting the instrument.

To start the computer workstation:

Step Action

1 Power on the monitor.

2 Power on the computer. 

The computer boots and then the Begin Logon dialog box opens.

3 Press Ctrl + Alt + Delete and enter the user name and, if applicable, a password.

♦ The default user name for the workstation is 3100-AvantUser. Do not change 
this user name.

♦ There is no default password. If you would like to use a password, your system 
administrator can create one.

♦ If the computer is connected to a network, you do not need to log on to the 
network before starting the instrument.

♦ OrbixWebTM Daemon and AEServer will launch automatically. If they do not 
launch, double-click on the OrbixWeb Daemon and AEServer shortcuts on the 
Desktop.

– OrbixWeb Daemon must be running for the ABI PRISM® 3100-Avant Data 
Collection software to run

– AEServer must be running for data extraction and analysis to occur
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Starting the Instrument

Starting the
Instrument

To start the 3100-Avant Genetic Analyzer:

Step Action

1 On the instrument, ensure that the:

♦ Oven door is closed and locked

♦ Instrument doors are closed

Note If the doors are open during power on, the red failure light will illuminate.

2 On the computer, ensure that the:

♦ Computer is powered on (see “Starting the Computer” on page 2-8)

♦ Microsoft® Windows NT® operating system has loaded

Note The computer must be on and running the Windows NT operating system 
because the instrument must copy the firmware from the computer.

3 Turn on the instrument by pressing the on/off button on the front of the instrument.

Note While the instrument is booting up and performing self-checks, the yellow 
status light will blink. 

4 Ensure the green status light is on and constant before proceeding. 

Note If the green light does not come on, start the data collection software and 
view the event log. The pathway to the event log is:

D:\AppliedBio\3100-Avant\Data Collection

Press the on/off button to start the instrument

Status lights 
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Starting the 3100-Avant Data Collection Software

Before You Begin

Starting the Data
Collection Software

To prepare to start the data collection software: 

Step Action

1 Ensure that the instrument is powered on and that the green status light is on solid 
(not flashing).

2 Ensure that AEServer and OrbixWeb Daemon are running by finding their buttons 
on the Windows NT taskbar.

♦ If AEServer is not running, select Start > Applied Biosystems > 3100-Avant 
Utilities > AEServer.

♦ If OrbixWeb Daemon is not running, select Start > Applied Biosystems > 
OrbixWeb Daemon.

IMPORTANT AEServer and OrbixWeb Daemon must be started before the data 
collection software can run.

To start the data collection software: 

Step Action

1 Select Start > Applied Biosystems > 3100-Avant Data Collection or use the shortcut 
located on the desktop.

Note To create a shortcut: (a) Navigate to 3100-Avant Collection.bat in the 
following directory: D:\AppliedBio\3100-Avant\Bin. (b) Right-click the file. (c) Click 
Create Shortcut. This creates a shortcut named Shortcut to 3100-Avant Collection 
Software. (d) Drag the shortcut to the desktop. 

The data collection software starts and the following window opens:
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Software Menus Below is a flowchart of the software menus in the data collection software. Refer to the 
ABI PRISM® 3100 Genetic Analyzer and 3100-Avant Genetic Analyzer User Reference 
Guide (P/N 4335393) for more information.

File

Main Menus Submenus Submenus

3100/3100-Avant 
 Data Collection
software window
with tabs:
• Plate View
• Run View
• Status View
• Array View
• Capillary View

Service

Instrument

View

Tools

Verify Instrument

Send SCPI Command

Run Service Module

Help About Data Collection

Import Plate

Override Spatial Calibration

Override Spectral Calibration

Exit

Plate View

Run View

Status View

Array View

Capillary View

Instrument Status Monitor

Preferences

Sequence Collector Project Info

Data Collection

Data Analysis

Run

Skip to Next Run

Pause

Stop

Manual Control

Data Aquisition

Set Color

Display Run Data

Display EPT Data

Extract Data into Sample Files

Display Entire Run

Plate Editor

Module Editor

Change Polymer Wizard

Install Capillary Array Wizard

Autosampler Calibration Wizard

Perform Spatial Calibration

Display Spatial Calibration

Display Spectral Calibration

Set Active Spectral Calibration

Update Capillary Array Info
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Setting Software Preferences

Overview The data collection software preferences are set during instrument installation; 
however, you can view or change these preferences in the Setting Preferences dialog 
box.

Defining the Setting
Preferences
Dialog Box

To set the preferences: 

Step Action

1 Select View > Preferences.

2 In the Setting Preferences dialog box, select the Data Collection tab, if it is not 
already selected.

3 In the Data Collection tab, set the following preferences:

a. In the Instrument Name field, enter a name for the 3100-Avant instrument.

b. If you are importing plates from a database, then select the Enable plate import 
from database check box and enter a polling interval.

4 Select the Data Analysis & Extraction tab.

If you are generating… Then…

sample files complete step 5 and skip step 6.

database file proceed to step 6.
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5 For sample files, define the following:

a. In the Analysis & Extraction section, the Enable AutoAnalysis check box is 
selected as default. Clear the box if you do not want your samples autoanalyzed.

b. In the Data Extraction Folder Root section, use the default or click Browse to 
select a folder location for all generated data.

c. In Sample File Options section, select how you want your sample files grouped. 
Select the By run option button to group by individual run or select the By plate 
option button to group by the entire plate.

d. In the Sample File Name Format section, use the drop-down lists to define the 
sample file name format. A prefix and/or suffix can be added as needed.

e. In the Run Folder Name Format section, use the drop-down lists to define the 
sample file name format. A prefix can be added as needed.

f. Click OK.

To set the preferences: (continued)

Step Action

From drop-down list 2

1 2
3 4

From drop-down list 3

From drop-down list 1

Select formats from the 
drop-down list to create 
custom sample file names

Identifier Origin

Run ID Generated by the data collection software

Sample Name Taken from the Plate Editor spreadsheet entry

Well Position Taken from the sample’s position on the plate (column 
letter and row number, e.g., C3)

Plate Name Taken from the Plate Editor dialog box entry

Instrument ID Taken from the Data Collection page preferences entry

Array ID Taken from the Install Capillary Array or Update Capillary 
array wizard entry
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6 For database files, define the following:

a. In the Analysis & Extraction section, select Extract to Sequence Collector.

The Enable AutoAnalysis check box is selected as default. Clear the box if you 
do not want your samples autoanalyzed.

b. In the Data Extraction Folder Root section, use the default or click Browse to 
select a folder location for all generated data.

c. In the Sequence Collector Login section, define the server, DB name, login, and 
password for the database you are using.

d. In the Sequence Collector Naming Format section, use the drop-down lists to 
define the sample file name format. Add a prefix and/or suffix as needed.

e. Click OK.

To set the preferences: (continued)

Step Action

Identifier Origin

Run ID Generated by the data collection software

Sample Name Taken from the Plate Editor spreadsheet entry

Well Position Taken from the sample’s position on the plate (column 
letter and row number, e.g., C3)

Plate Name Taken from the Plate Editor dialog box entry

Instrument ID Taken from the Data Collection page preferences entry

Array ID Taken from the Install Capillary Array or Update Capillary 
array wizard entry
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Section: Preparing the Instrument 

In This Section The following topics are covered in this section:

Topic See Page

Setting Up the Instrument 2-16

Preparing Buffer and Filling the Reservoirs 2-19

Calibrating the Instrument 2-22
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Setting Up the Instrument 

Using Manual
Control Commands

While you are setting up the instrument, you may find manual control useful. For 
example, you can use manual control commands to move the syringe plungers up and 
down, open or close the pin valve, and turn on the oven before starting your run. Refer 
to the ABI PRISM® 3100 Genetic Analyzer and 3100-Avant Genetic Analyzer User 
Reference Guide (P/N 4335393) for more information.

Attaching the
Polymer Blocks

To attach the polymer blocks to the instrument:

Step Action

1 If necessary, clean the polymer blocks and the tubing as instructed on page 4-29.

2 Push the upper polymer block onto the two guide pins on the instrument. Leave a 
1-inch gap between the block and the back of the instrument. 

3 Install the lower polymer block. Ensure the block is pushed all the way against the 
instrument.

4 Connect the tubing between the two blocks.

a. Insert one ferrule into the upper polymer block and rotate clockwise until finger 
tight.

b. Insert the other ferrule into the lower polymer block and rotate clockwise until 
finger tight.

IMPORTANT Do not overtighten.

5 Install clean drip trays if they are not already on the instrument.
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Selecting a Capillary
Array

Use the table below to select the correct capillary array length for your application.

IMPORTANT Fragment Analysis: For optimal resolution, as in the case of fine mapping, 
Applied Biosystems recommends using the 36-cm capillary array. However, the 22-cm capillary 
array can be used to rapidly scan the genome when using markers less than 360 bp. Refer to 
ABI PRISM® 3100 22-cm Capillary Array for High Throughput Microsatellite and SNP 
Genotyping User Bulletin for more information.

Installing or
Replacing the

Capillary Array

IMPORTANT The capillary array length that you are using must match the capillary array 
length in the instrument database. If they do not match then data quality could be compromised.

If necessary, install a capillary array using the Install Capillary Array wizard. For 
instructions, see “Installing and Removing the Capillary Array” on page 4-15.

Alternatively, you can install the capillary array without using the wizard. Update the 
capillary array information using the Update Capillary Array Info utility. For instructions, 
see “Installing the Capillary Array Without Using the Install Wizard” on page 4-16.

Application or Kit
Capillary Array 

Length (cm)

Fragment Analysis

 ABI PRISM® SNaPshot® Multiplex System 22

36

♦ ABI PRISM® Linkage Mapping Set v2.5

♦ ABI PRISM® Mouse Mapping Set v1.0

♦ Custom oligos

22

36

DNA Sequencing

Ultra rapid sequencing 36

Rapid sequencing 36

Standard sequencing 50

Long read sequencing 80
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Selecting the
Polymer

Use the following table to select the correct polymer for your application.

Preparing and
Installing the

Syringes

IMPORTANT Wear gloves while performing the following procedure, and any other time you 
handle the capillary array, glass syringes, septa, or buffer reservoirs. 

CHEMICAL HAZARD. POP polymer may cause eye, skin, and respiratory tract 
irritation. Please read the MSDS, and follow the handling instructions. Wear appropriate 
protective eyewear, clothing, and gloves. Use for research and development purposes only.

When to Add or
Change Polymer

If syringes containing polymer are on the instrument, use the table below to determine 
whether to add or change the polymer before proceeding with instrument preparation.

IMPORTANT Always replace polymer that is older than 1 week.

IMPORTANT Ensure that there are no air bubbles in the upper polymer block and polymer 
block tubing before proceeding. To remove any air bubbles, see page 4-32.

Application Capillary Length Polymer

Fragment analysis all lengths POP-4

Ultra rapid sequencing 36

Long read sequencing 80

Rapid sequencing 36 POP-6

Standard sequencing 50

To prepare and install the syringes:

Step Action

1 If necessary, clean and inspect the syringes as instructed on page 4-22.

2 Prime and fill the syringes with the correct polymer as instructed on page 4-24.

3 Install the syringes as instructed on page 4-25.

CAUTION!

If polymer on the instrument is... Then...

less than 1 week old, and

sufficient in quantity to complete 
your runsa

a. A run uses ~20 µL of polymer. A minimum of 100 µL of polymer is required for the instrument to operate.

Ensure that there are no air bubbles, and then proceed 
with instrument preparation.

less than 1 week old, and

insufficient in quantity to complete 
your runs

Fill the syringes and the upper polymer block with 
polymer by following the Change Polymer wizard (see 
page 4-10).

more than 1 week old a. Remove and clean the polymer blocks and syringes 
(see “Polymer Blocks” on page 4-27 and “Syringes” 
on page 4-21).

b. Fill the syringes and the upper polymer block with 
polymer by following the Change Polymer wizard 
(see page 4-10).

wrong type (changing between 
POP-4 and POP-6 polymers)
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Preparing Buffer and Filling the Reservoirs

Required Materials The following materials are required to prepare 1X running buffer:

♦ 10X Genetic Analyzer Buffer (P/N 401884)

♦ Quality deionized water

CHEMICAL HAZARD. 10X Genetic Analyzer Buffer with EDTA may cause 
eye, skin, and respiratory tract irritation. Read the MSDS, and follow the handling instructions. 
Wear appropriate protective eyewear, clothing, and gloves.

Making Buffer for a
Single Run

Storing the Buffer The 1X running buffer can be stored at 2 to 8 °C for up to 1 month.

Replacing the Buffer Replace the 1X running buffer in the anode buffer reservoir and the cathode buffer 
reservoir daily, or before each batch of runs.

IMPORTANT Failing to replace buffer may lead to loss of resolution and data quality.

IMPORTANT Replenishing buffer and placing the plate requires that the autosampler be in the 
forward position, with the capillary tips removed from the buffer solution. Do not leave the 
autosampler in this position for an extended time because the capillaries can dry out. 

Filling the Water
and Cathode Buffer

Reservoirs

IMPORTANT Wear gloves while performing the following procedure, and any other time you 
handle the capillary array, glass syringes, septa, or buffer reservoirs. 

CAUTION!

To prepare 50 mL of 1X running buffer:

Step Action

1 Add 5 mL of 10X Genetic Analyzer buffer into a graduated cylinder.

2 Add deionized water to bring the total volume up to 50 mL.

3 Mix well.

To fill the water and cathode buffer reservoirs: 

Step Action

1 Close and lock the oven door and then close the instrument doors.

2 Press the Tray button on the outside of the instrument to bring the autosampler to 
the forward position.

3 Wait until the autosampler has stopped moving, and then open the instrument 
doors. 

4 Remove the cathode buffer reservoir and water reservoirs from the instrument.

Tray button 
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Filling the Anode
Buffer Reservoir

Change the anode buffer:

♦ Before each run, or at least every 24 hours

♦ Every time you fill the polymer block with new polymer

5 Dispose of remaining fluids and rinse out the reservoirs with deionized water.

Note The waste is very dilute; however, you should follow your company’s waste 
disposal practices for appropriate disposal procedures. 

6 Rinse the cathode reservoir with 1X running buffer, and then fill to the line with 1X 
running buffer (about 16 mL).

7 Fill the water reservoirs to the line with quality deionized water (about 16 mL). 

8 Place a clean reservoir septa on each reservoir, and dry the outside of the 
reservoirs using a lint-free wipe. 

Be sure that the septa fit snugly and flush on the tops of the 
reservoirs in order to prevent damaging the capillary tips.

9 Place the reservoirs into position on the autosampler as shown below.

10 Close the instrument doors.

Note Closing the doors returns the autosampler to the home position, placing the 
tips of the capillaries in water.

To fill the water and cathode buffer reservoirs: (continued)

Step Action

CAUTION!

Septa is lying flat on the reservoir 

Fill line

Water reservoir
(rinse)

Cathode reservoir
(1X running buffer)

Water reservoir
(waste)

Water reservoir 
(spare)

1

2

3

4

To fill the anode buffer reservoir to the fill line with 1X running buffer: 

Step Action

1 Remove the anode buffer reservoir by firmly pulling down and twisting slowly. 

2 Discard the used buffer appropriately.

3 Clean and rinse the reservoir with deionized water, and then rinse with buffer.
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4 Fill the reservoir to the fill line with fresh 1X running buffer (about 9 mL).

5 Put the anode buffer reservoir on the instrument. 

Note The meniscus should line up with the fill line.

6 If the reservoir fills with fluid, repeat this procedure to discard and replace the 
running buffer. 

Note The reservoir could fill during bubble clearing.

To fill the anode buffer reservoir to the fill line with 1X running buffer: (continued)

Step Action

Fill line
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Calibrating the Instrument

Spatial Calibration If necessary, perform a spatial calibration.

A spatial calibration must be performed after each time you:

♦ Install a capillary array

♦ Replace a capillary array with a new one

♦ Move or remove the capillary array temporarily from the detection block

For instructions, see “Spatial Calibration” on page 3-3.

Spectral Calibration If necessary, perform a spectral calibration.

A spectral calibration must be performed:

♦ Whenever you use a new dye set on the instrument

♦ After the laser has been realigned by a service engineer

♦ After the CCD camera has been realigned/replaced by a service engineer

♦ If you begin to see pull-up and/or pull-down peaks consistently

♦ For fragment analysis only, if you change the capillary array length

For instructions, see “Spectral Calibration” on page 3-13.

Affect of Capillary Array Length 

The affect of the capillary array length on spectral calibrations vary between 
sequencing and fragment analysis applications.

♦ Sequencing analysis

Typically, for each dye set, a single spectral calibration can be used for all capillary 
array lengths and polymer combinations.

♦ Fragment analysis

For each dye set, a separate spectral calibration must be used for the 22- and 
36-cm capillary arrays. Refer to “Activating a Spectral Calibration for a Dye Set” on 
page 3-31, for information on how to switch calibrations.
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Section: Working with Samples

In This Section The following topics are covered in this section:

Topic See Page

Plate Mapping 2-24

Preparing and Loading Samples 2-26
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Plate Mapping

Introduction Below is information on how samples are scheduled for injection based on the plate 
configuration. This is helpful for arranging samples with high priority or running a plate 
that is partially filled.

The instrument injects samples using an alphanumeric system that schedules runs 
based on the following criteria:

♦ Order the plates are linked and then,

♦ Run module name with numerics scheduled first (0...9) followed by upper case 
then lower case

If all run module names are identical, runs are scheduled as outlined below. 

Selecting a Plate
Type

The 96- and 384-well plates can be used for fragment analysis and sequencing 
applications.

IMPORTANT The 384-well plate can be used for sequencing applications, but sample quality 
may be affected. Hi-Di™ formamide exposed to air for more than 24 hours begins to break 
down. The breakdown of Hi-Di formamide can compromise sample quality.

CHEMICAL HAZARD. Formamide is harmful if absorbed through the skin 
and may cause irritation to the eyes, skin, and respiratory tract. It may cause damage to the 
central nervous system and the male and female reproductive systems, and is a possible birth 
defect hazard. Please read the MSDS, and follow the handling instructions. Wear appropriate 
protective eyewear, clothing, and gloves.

96-Well Plate
Mapping

For a 96-well plate, injections are made from four consecutive wells. A full plate of 96 
sample requires 24 runs to inject all samples once.

Below is an example of a 96-well plate. The gray circles represent samples, and the 
number in the well indicates capillary number. It takes four runs to inject 16 samples. 

WARNING!

ABCDEFGH

1

12341234

12341234

2
3

4
5

6
7

Run 4 Run 3

Run 1Run 2
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384-Well Plate
Mapping

For a 384-well plate, injections are made from every other well. A full plate of 384 
sample requires 96 runs to inject all samples once.

Below is an example of the injection pattern for the first six injections. The light gray 
circles represent samples and the dark gray circles indicate the pick up pattern for 
injection.

ABCDEFGHIJKLMNOP

1
2

3
4

5
6

7
8

9
10

11
12

13
14

15
16

ABCDEFGHIJKLMNOP

1
2

3
4

5
6

7
8

9
10

11
12

13
14

15
16

1

ABCDEFGHIJKLMNOP

1
2

3
4

5
6

7
8

9
10

11
12

13
14

15
16

1

Run 1 Run 2 Run 3

ABCDEFGHIJKLMNOP

1
2

3
4

5
6

7
8

9
10

11
12

13
14

15
16

1

ABCDEFGHIJKLMNOP

1
2

3
4

5
6

7
8

9
10

11
12

13
14

15
16

1 7

ABCDEFGHIJKLMNOP

1
2

3
4

5
6

7
8

9
10

11
12

13
14

15
16

1

Run 6Run 5Run 4
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Preparing and Loading Samples

Chemical Hazard
Warning

CHEMICAL HAZARD. All chemicals on the instrument, including liquid in the 
lines, are potentially hazardous. Please read the MSDS, and follow the handling instructions. 
Wear appropriate eyewear, protective clothing, and gloves when working on the instrument.

References for
Sample Preparation

For information on required materials, sample preparation, and plate centrifugation, 
refer to the appropriate guide as follows: 

Loading the Samples

For... Refer to the...

DNA sequencing samples ABI PRISM® Automated DNA Sequencing Chemistry Guide 
(P/N 4305080) or kit protocol

Fragment analysis samples  Kit protocol

To load the samples: 

Step Action

1 Dispense 10 µL of the denatured samples into the wells of a plate.

2 Tap down or centrifuge the plate so that each sample is positioned at the bottom of 
its well. Your samples should:

3 Leave the plate on ice until you are ready to prepare the plate assembly and place 
the assembly on the autosampler.

Look like this... Not look like this... Not look like this...

The sample is 
positioned correctly in 
the bottom of the well.

The sample lies on the 
side wall because the 
plate was not 
centrifuged.

An air bubble lies at the 
bottom of the well 
because the plate was 
not centrifuged with 
enough force or time.
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Section: Working with Plate Records

In This Section The following topics are covered in this section:

Topic See Page

About Plate Records 2-28

Creating a Plate Record for Fragment Analysis 2-29

Creating a Plate Record for DNA Sequencing Analysis 2-35

Using a Previous Plate Record to Complete a New Plate Record Automatically 2-41
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About Plate Records

Overview A plate record is similar to a sample sheet or an injection list that you may have used 
with other ABI PRISM® instruments. 

Plate records are data tables in the instrument database that store information about 
the plates and the samples they contain. Specifically, a plate record contains the 
following information:

♦ Plate name, type, and owner

♦ Position of the sample on the plate (well number)

♦ Sample name

♦ Dye color of size standard (fragment analysis only)

♦ Mobility file (DNA sequencing analysis only)

♦ Comments about the plate and about individual samples

♦ Dye set information

♦ Project name (this entry is mandatory, even when Sequence Collector is not used)

♦ Name of the run module (run modules specify information about how samples are 
run)

♦ Name of the analysis module (analysis modules specify how raw data is 
autoanalyzed at the end of the run)

When to Create a
Plate Record

A plate record must be created for each plate of samples for the following types of 
runs: 

♦ Fragment analysis

♦ DNA sequencing

♦ Spectral calibrations

Note For fragment analysis and sequencing runs, there is no need to re-create a plate record 
for a plate that has failed. Simply edit the plate record to add a run module and an analysis 
module column to the rows that need to be rerun. This will move the existing plate record from 
the Processed window to the Pending window.

Plate records can be created before or after placing the plates on the instrument. New 
plate records can be created while a run is in progress.

About Creating
Plate Records

The next three sections cover the most common method for creating a plate record. 
Other options exist for creating plate records from tab delimited files.

Refer to the ABI PRISM® 3100 Genetic Analyzer and 3100-Avant Genetic Analyzer 
User Reference Guide (P/N 4335393) for more information.

Plate Records for
Spectral Runs

For information on creating plate records for spectral calibration runs, see “Creating a 
Plate Record” on page 3-20.
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Creating a Plate Record for Fragment Analysis

Entering Plate
Record Information

Note You can create a plate record while a run is in progress.

To enter plate record information: 

Step Action

1 Click the Plate View tab in the data collection software window to go to the Plate 
View page.

2 In the Plate View page, click New.

The Plate Editor dialog box opens.

3 Enter your plate name and select the application and plate type. Comments are 
optional.

Note When naming the plate, you can use letters, numbers, and the following 
punctuation only: -_(){}#.+. DO NOT USE SPACES.

4 When done, click Finish.

The Plate Editor spreadsheet opens.

Plate View tab
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Entering Sample
Information

To enter sample information and save the plate record: 

Step Action

1 In the Plate Editor spreadsheet, type the names of all the samples in the Sample 
Name column. 

♦ Sample names are limited to a maximum of 32 characters.

♦ When naming the samples, you can use letters, numbers, and the following 
punctuation only: -_(){}#.+. DO NOT USE SPACES.

♦ In the default naming convention, the sample name you type is incorporated into 
the sample file name. For example:

\

Note The sample file naming convention used can be changed in the Preferences 
dialog box. See page 2-12 for details.

2 Change the size standard dye color, if necessary. The default is red. Use red for 
4-dye applications and orange for 5-dye applications.

a. Click on the dye color you want to use.

b. Select all the samples.

c. Select Edit > Fill down.

3 Type in Color info and Color Comment, if needed.

Note Color Info and Color Comment information is the same as Sample Info and 
Sample Comment in the ABI PRISM® Genotyper® software. Refer to the ABI PRISM® 
Genotyper® Software User’s Manual for more information.

4 Enter a Project name.

Note A project name is required for every sample, even if a Sequence Collector 
database is not used.

a. Click in the Project Name cell for Well A1. 

b. Select a project name in the drop-down list.

c. To assign the same project name to each sample in the plate record:

– Click the column header to select the whole column.

– Press Ctrl+D.

Note Press Ctrl+D to fill down whenever a field is the same for all samples in the 
plate record.

PlateName_A01_MySample__01.fsa

Plate name you type

Well position

Capillary position

Sample name you type

Fragment analysis file extension

Note You must select a project.
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5 For each sample, select the appropriate Dye Set in the drop-down list. 

The following table shows the dye set to select based on your application.

IMPORTANT Be sure to select the correct dye set for your run(s). Data collected 
with the incorrect dye set selected cannot be saved and the runs will have to be 
repeated because multicomponenting is applied during collection. 

To enter sample information and save the plate record: (continued)

Step Action

Application or Kit Dye Set Matrix Standard Set

Custom oligos D DS-30 

♦ ABI PRISM Mouse Mapping Set v1.0

♦ Custom oligos

D  DS-31

(DS-30 + VIC™ Matrix 
Standard)a

a. Replace the HEX™ matrix standard in DS-30 set with the VIC matrix standard.

 ABI PRISM® SNaPshot® Multiplex System E5 DS-02

♦ ABI PRISM® Linkage Mapping Set v2.5

♦ Custom Oligos

G5 DS-33
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6 For each sample, select the appropriate Run Module in the drop-down list. 

The following table shows the run module to select based on your run type:

Note If you select different modules for different samples, the samples will be 
automatically grouped so that all samples with the same run module are run at the 
same time. Runs are scheduled alphanumerically by run module name, not by the 
order indicated in the plate record, nor by sample name.

To enter sample information and save the plate record: (continued)

Step Action

Application or Kit

Capillary 
Array 

Length Run Module

SNaPshot Multiplex 
System

22 cm SNP22_POP4DefaultModule

36 cm SNP36_POP4DefaultModule

♦ LMS v2.5

♦ ABI PRISM Mouse 
Mapping Set v1.0

♦ Custom oligos

22 cm GeneScan22_POP4DefaultModule

36 cm GeneScan36_POP4DefaultModule

LMS v2.5 36 cm GeneScan36vb_POP4DefaultModule

Note This module supports specific 
fragment analysis applications using 
the G5 chemistry
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7 For each sample, select the appropriate Analysis Module from the drop-down list.

IMPORTANT The Enable AutoAnalysis preference must be selected if analysis is 
to take place automatically after the run (see page 2-12).

The following table shows which analysis module to select based on the number of 
fragments in your size standard:

Note You can examine the settings for each of these files using GeneScan 
Analysis Software. The meanings of the settings are described in the ABI PRISM® 
GeneScan® Analysis Software v. 3.7 NT User Guide.

8 If you want to run the same sample again, select a second run module and a 
second analysis module. You can run a sample in a linked plate up to five times.

Note Samples will be automatically grouped so that all samples with the same 
run module are run sequentially. 

To enter sample information and save the plate record: (continued)

Step Action

If using size standard... Select this analysis module...

GeneScan™120 GS120Analysis.gsp

GeneScan™ 400HD GS400HDAnalysis.gsp

GeneScan™ 350 GS350Analysis.gsp

GeneScan™ 500 GS500Analysis.gsp

GeneScan™ 400 (see footnote) GS400CubicAnalysis.gspa

a. These modules are for advanced users with specific sizing needs. See the ABI PRISM® 
GeneScan® Analysis Software v. 3.7 NT User Guide.

GS400Ord2Analysis.gspa
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9 a. Verify that the plate record is correct and complete (contains the following 
required information: sample name, dye set, size standard color, project, and run 
module).

b. Click OK.

An example of a completed plate record is shown below.

Note It may take a few minutes for the new plate record to be saved to the 
database and added to the Pending Plate Records table as shown below.

To enter sample information and save the plate record: (continued)

Step Action
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Creating a Plate Record for DNA Sequencing Analysis

Entering Plate
Record Information

Note You can create a plate record while a run is in progress.

To enter plate record information: 

Step Action

1 Click the Plate View tab in the data collection software.

2 In the Plate View page, click New. 

The Plate Editor dialog box displays.

3 Enter your plate name and select the application and plate type. Comments are 
optional.

Note When naming the plate, you can use letters, numbers, and the following 
punctuation only: -_(){}#.+. DO NOT USE SPACES.

Note The 384-well plate can be used for sequencing applications but sample 
quality may be affected. Hi-Di™ formamide exposed to air for more than 24 hours 
begins to breakdown. The breakdown of Hi-Di formamide can compromise sample 
quality.

4 When done, click Finish.

The Plate Editor spreadsheet opens.

Plate View tab
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Entering Sample
Information

To enter sample information and save the plate record: 

Step Action

1 In the Plate Editor spreadsheet, type the names of all the samples in the Sample 
Name column. 

♦ Sample names are limited to a maximum of 32 characters.

♦ When naming the samples, you can use letters, numbers, and the following 
punctuation only: -_(){}#.+. DO NOT USE SPACES.

♦ In the default naming convention, the sample name you type is incorporated into 
the sample file name. For example:

\

♦ The sample file naming convention used can be changed in the Preferences 
dialog box. See page 2-12 for details.

2 For each sample, select the appropriate Dye Set in the drop-down list.

Use the table below to identify the correct dye set for the chemistry you are using.

IMPORTANT Be sure to select the correct dye set for your run(s). Data collected 
with the incorrect dye set selected cannot be saved and the runs will have to be 
repeated because multicomponenting is applied during collection.

PlateName_A01_MySample__01.ab1

Plate name you type

Well position

Capillary position

Sample name you type

Sequencing analysis file extension

Chemistry Dye Set

ABI PRISM® BigDye™ Terminator E

ABI PRISM® dRhodamine Terminator

ABI PRISM® BigDye™ v3.0 Terminator Z
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3 For each sample, select the appropriate dye terminator chemistry Mobility File in 
the drop-down list.

IMPORTANT Mobility files for dye primer chemistry also display in the drop-down 
list, if ABI PRISM® Sequencing Analysis Software v3.7 is loaded on the computer. 
Dye terminator files start with “DT” and dye primer files start with “DP”. Do not use 
the “DP” files.

You may need to resize the column to see the whole file name. To do this, place the 
pointer between the column headers (it will become a double-headed arrow) and 
drag right.

The following table shows which mobility file to select based on your sequencing 
chemistry:

To enter sample information and save the plate record: (continued)

Step Action

Dye terminator chemistry mobility 
files loaded by data collection

DNA Sequencing 
Chemistry

Capillary Array 
Length (cm) Mobility File

ABI PRISM BigDye 
Terminator 

36: ultra rapid DT3100POP4LR{BD}v1.mob

80: long read

36: rapid read DT3100POP6{BD}v2.mob

50: std run

ABI PRISM dRhodamine 
Terminator

36: ultra rapid DT3100POP4{dRhod}v2.mob

80: long read

36: rapid read DT3100POP6{dRhod}v2.moba

a. If Sequencing Analysis software is on the computer, then two versions of the 
DT3100POP6{dRhod} mobility file exist. Use the newest version, 
DT3100POP6{dRhod}v2.mob, instead of DT3100POP6{dRhod}v1.mob.

50: std run

ABI PRISM BigDye v3.0 
Terminator

36: ultra rapid DT3100POP4{BDv3}v1.mob

80: long read

36: rapid read DT3100POP6{BDv3}v1.mob

50: std run
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4 Enter a Project Name.

Note A project name is required for every sample, even if a Sequence Collector 
database is not used.

a. Click in the Project Name cell for Well A1. 

b. Select a project name in the drop-down list.

c. To assign the same project name to each sample in the plate record:

– Click the column header to select the whole column.

– Press Ctrl+D

Note Press Ctrl+D to fill down whenever a field is the same for all samples in the 
plate record.

5 For each sample, select the appropriate Run Module from the drop-down list. 

The following table shows the run module to select based on your run type.

Note If you select different modules for different samples within the same plate 
record, the samples will be automatically grouped so that all samples with the same 
run module are run at the same time. Runs are scheduled alphanumerically by run 
module name, not by the order indicated in the plate record, nor by sample name. 
To see the scheduled order of the runs, select the Run View tab.

To enter sample information and save the plate record: (continued)

Step Action

Note You must select a project name.

DNA Sequencing 
Run Type

Capillary Array 
Length (cm) Run Module

Ultra rapid 36 UltraSeq36_POP4DefaultModule

Rapid 36 RapidSeq36_POP6DefaultModule

Standard 50 StdSeq50_POP6DefaultModule

Long read 80 LongSeq80_POP4DefaultModule
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6 For each sample, select the appropriate Analysis Module from the drop-down list.

IMPORTANT The Enable AutoAnalysis preference must be selected if analysis is 
to take place automatically after the run (see page 2-12).

The following table shows the analysis module to select based on your run type:

Note You can examine the settings for each of these files using DNA Sequencing 
Analysis software. The meanings of the settings are described in the ABI PRISM® 
DNA Sequencing Analysis Software v. 3.7 NT User’s Manual.

7 If you want to run the same sample again, select a second run module and a 
second analysis module. You can run a sample in a linked plate up to five times.

Samples will be automatically grouped so that all samples with the same run 
module are run sequentially. 

To enter sample information and save the plate record: (continued)

Step Action

DNA Sequencing Run Type Analysis Module

Ultra rapid BC-3100APOP4UR_SeqOffFtOff.saz

Rapid DNA BC-3100APOP6RR_SeqOffFtOff.saz

Standard BC-3100APOP6SR_SeqOffFtOff.saz

Long read BC-3100APOP4_80cm_SeqOffFtOff.saz
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8 a. Verify that the plate record is correct and complete (contains the following 
required information: sample name, dye set, mobility file, project, and run 
module).

b. Click OK. 

An example of a completed plate record is shown below.

Note It may take a few minutes for the new plate record to be saved to the 
database and added to the Pending Plate Records table as shown below.

To enter sample information and save the plate record: (continued)

Step Action
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Using a Previous Plate Record to Complete a New Plate Record Automatically 

Reusing Plate
Records

You can reuse plate records by importing data from an existing plate into the current 
plate. The imported plate must match the configuration (application type and number 
of wells) of the current plate.

To import plate data: 

Step Action

1 Click the Plate View tab.

The Plate Editor dialog box opens.

2 In the Plate View tab, click New.

3 In the Plate Editor dialog box, enter your plate name and select the application and 
plate type. Comments are optional. When done, click Finish.

Note When naming the plate, you can use letters, numbers, and the following 
punctuation only: -_(){}#.+. DO NOT USE SPACES.

4 Select File > Import data in the Plate Editor spreadsheet.

Plate View tab
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5

6 A Progress box opens.

After the importing is complete, the sample sheet is filled with the information from 
the imported plate data. If necessary, change the sample name(s) to reflect the new 
names for your samples.

To import plate data: (continued)

Step Action

If there are… Then…

matching plates the Import data dialog box opens with a drop-down 
list of matching plates to choose from.

a. Select a plate from the list.

b. Click OK.

c. Proceed to step 5.

no matching plates the following message box displays:

a. Click OK.

b. Use the standard method to complete a new plate 
record.
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Section: Working with Plates and Run Scheduling

In This Section The following topics are covered in this section:

Topic See Page

Working with Plate Assemblies 2-44

Placing the Plate onto the Autosampler 2-46

Linking and Unlinking a Plate 2-47

Run Scheduling 2-49
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Working with Plate Assemblies

Plate Assembly
Components

The plate assembly components are assembled as follows:

Plate retainer

Sample plate 

Plate base

Plate septa
1 2 3

G
R

20
50
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Preparing a Plate
Assembly

To prepare a plate assembly: 

Step Action

1 Secure a clean and dry plate septa on the sample plate.

IMPORTANT Never use warped plates.

IMPORTANT Ensure that the plate septa lies flat on the plate.

2 Place the sample plate into the plate base. 

3 Snap the plate retainer onto the plate and plate base.

4 Ensure that the plate retainer holes are aligned with the holes in the septa strip.

IMPORTANT Damage to the array tips will occur if the plate retainer and septa 
strip holes do not align correctly.

The plate retainer holes 
must align with the holes in 
the plate septa.
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Placing the Plate onto the Autosampler

Placing the Plate
onto the

Autosampler

To place the plate onto the autosampler:

Step Action

1 Place the plate assembly on the autosampler in position B.

Note There is only one orientation for the plate, with the notched end of the plate 
base away from you.

IMPORTANT Ensure the plate assembly fits flat in the autosampler. Failure to do 
so may allow the capillary tips to lift the plate assembly off of the autosampler.

2 When the plate is correctly positioned, the plate position indicator on the Plate View 
page changes from gray to yellow.

Verify that this has happened.

3 Close the instrument doors.

Note Closing the doors returns the autosampler to the home position, placing the 
tips of the capillaries in buffer.

G
R

21
42

Plate position B
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Linking and Unlinking a Plate

Overview The procedure below describes how to link a plate on the autosampler to the plate 
record you have created. This must be done before a plate can be run.

Linking a Plate to a
Plate Record

To link a plate to a plate record: 

Step Action

1 Click the Plate View tab.

2 In the Plate View page:

a. In the Pending Plate Records table, click the plate record for the plate you are 
linking.

b. Click the plate position indicator that corresponds to the plate you are linking.

3 Add the required information to the plate record:

a. Unlink the plate record, if necessary. (The plate record returns to the Pending 
Plate Records table.)

b. Double-click the plate record name to open it.

c. Correct the plate record and click OK.

d. Link the plate record to the plate again.

Plate View tab

Click the plate record 

Click anywhere on the 
plate position indicator

Does the following message display?
Then proceed 
to step…

Yes 3

No 4
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Unlinking a Plate
Record

4 Verify that the plate has been linked. 

Once the plate has been linked, the:

♦ Run Instrument button in the toolbar is enabled, meaning that the instrument is 
ready to run.

♦ Plate position indicator for the linked plate becomes green. 

♦ Plate record moves from the Pending Plate Records table to the Linked Plate 
Records table. 

To link a plate to a plate record: (continued)

Step Action

Run Instrument 
button is enabled

Plate position 
indicator is green

Plate record is in the Linked Plate Records table

To unlink a plate record:

Step Action

1 In the Linked Plate Records table in the Plate View page, select the plate record 
that you want to unlink.

2 Click Unlink. 

If the plate record is... Then the plate record will...

completed go to the Processed Plate Records table and the plate 
position indicator will return to yellow.

not completed return to the Pending Plate Record table, and the 
plate position indicator will return to yellow.
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Run Scheduling

Sample Run Order The 3100-Avant Run Scheduler follows an alphanumeric system that schedules runs 
based on the run module name with numerics scheduled first (0...9) followed by upper 
case then lower case letters.

Note The analysis module of a sample plays no part in the order in which it will be run.

If all run module names are identical, runs are scheduled as outlined below. 

Capillary Array
Map

Below is the layout of the capillary numbers in the capillary array. The capillary array 
layout is the same for both 96- and 384-well plates.

96-Well Plate
Mapping

For a 96-well plate, injections are made from four consecutive wells. A full 96-well 
plate requires 24 runs to inject all samples once.

Note Multiple injections (Run Module 2 to 5) from the same well are run before moving to the 
next set of wells.

Capillary numbers:

Run 1 Run 2 Run 3 Run 4
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384-Well Plate
Mapping

For a 384-well plate, injections are made from every other well. A full 384-well plate 
requires 96 runs to inject all the samples once.

.

Note Multiple injections (Run Module 2 to 5) from the same well are run before moving to the 
next set of wells.

Viewing the Run
Schedule

After a plate is linked, use the Run View page to verify that runs are scheduled 
correctly. 

Note Although you can delete individual runs, you cannot alter the order in which the runs are 
scheduled. 

Run 1 Run 2 Run 3

Run 4 Run 5 Run 6

To view the scheduled runs:

Step Action

1 Click the Run View tab.

2 Select a row for any run. The corresponding wells to be injected for that run 
becomes highlighted in the plate diagram on the left. 

For more information about the Run View page, see page 2-62.

Plate View tab
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Continuous
Operation

If you wish to continuously run the instrument using different run module names, you 
must adhere to a strict run module naming convention that ensures a correct 
alphanumeric order for the duration of the continuous run period.

Deleted Runs
Rescheduled

The run scheduler re-initializes every time you use the plate editor to link or unlink a 
plate, create a new plate record, or edit an existing plate record. 

If you delete runs associated with a plate and then use the plate editor, the deleted 
runs will be rescheduled. Remove any unwanted runs in the Run View window.
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Section: Running the Instrument

In This Section The following topics are covered in this section:

Topic See Page

Launching the Run 2-54

Automatic Checking of Available Space on Drives D and E 2-55

Run Times 2-56

Controlling the Run 2-57

Continuous Runs 2-58

Using the Same Array for Sequencing and Fragment Analysis 2-59
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Launching the Run

Starting the Run

Startup Time When the run starts, the following module steps are performed.

Note A PostBatch Utility, which runs automatically, turns off the oven and the laser at end of a 
batch of runs.

To start a run:

Step Action

1 If you want to review the run schedule before beginning the run, click the Run View 
tab.

2 Click the green Run Instrument button in the toolbar.

3 The software will automatically check if the database and/or drive D are full.

If the database or 
drive D are… Then…

full a. proceed to “Automatic Checking of Available 
Space on Drives D and E” on page 2-55.

b. Make more space.

c. Click the green Run Instrument button.

not full the run will start.

 Module Steps Approximate Time

Turn Oven On N/A

Wait for oven to equilibrate
Initialize autosampler
Fill syringes

1 min 40 sec

Fill Array 2-3 min

PreRun 3 min

Inject samples 30 sec

Start separation
Ramp voltage

10 min

Collect Data Variable

Run ends: 
Leave oven on
Laser to idle

Until next run starts

Total time prior to separation:

♦ Cold start: ~16.5 min

♦ 2nd run: ~6.5 min
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Automatic Checking of Available Space on Drives D and E

Overview Before a run or batch of runs, the data collection software automatically checks the 
available space to ensure sufficient space to store the database and sample file data 
that will be created. 

3100-Avant Files
Drive D

The data collection software sends the following warning message to remove data 
when drive D is full.

Runs cannot be started until the data is removed from the drive. For information on 
archiving data, refer to “Creating a Data CD” on page 4-37.

Database
Drive E

The data collection software sends the following warning message when the database 
is getting full (~75% of 9 GB).

Runs cannot be started until the database is cleaned up. For information on using the 
Cleanup DB utility, refer to “Deleting Processed Frame Data” on page 4-39.
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Run Times

DNA Sequencing
Run Times

The following table lists the approximate run times of common DNA sequencing 
analysis runs:

Fragment Analysis
Run Times

The following table lists the approximate run times of common fragment analysis runs:

Type of Run Run Module Run Time

Ultra rapid DNA sequencing UltraSeq36_POP4DefaultModule 40 min

Rapid DNA sequencing RapidSeq36_POP4DefaultModule 1 h

Standard DNA sequencing StdSeq50_POP6DefaultModule 2 h 30 min

Long read DNA sequencing LongSeq80_POP4DefaultModule 3 h 45 min

Type of Analysis Run Module Run Time

Fragment analysis GeneScan22_POP4DefaultModule  20 min

Fragment analysis GeneScan36_POP4DefaultModule 45 min

Fragment analysis GeneScan36vb_POP4DefaultModule 45 min

SNP analysis SNP22_POP4DefaultModule 15 min

SNP analysis SNP36_POP4DefaultModule 30 min
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Controlling the Run 

Controlling the Run
Using the

Instrument Menu

You can use the Instrument menu to start, skip, pause, or stop a run.

Controlling the Run
Using the Toolbar

You can also use the toolbar at the top of the data collection software window to 
control the run.

To... Click... Comment

Start the run

Run Instrument 

♦ This begins all scheduled runs.

♦ The run starts only when set 
temperature is reached.

Pause the run

Pause 

Pausing the instrument for too long, 
especially after sample injection, will affect 
data quality. The best time to pause is 
before sample injection.

♦ Complete the current run, 
and

♦ Stop the other scheduled 
runs 

a. Stop 

b. After run in the Question dialog box

♦ Stop the current run, and 

♦ Stop the other scheduled 
runs

a. Stop 

b. Now in the Question dialog box

When you click Now, the run files extract 
automatically. The files will be 
automatically analyzed if the AutoAnalysis 
preference is enabled.

To recover data from a stopped run, see 
“Recovering Data If Autoextraction Fails” on 
page 2-70.

♦ Stop the current run, and

♦ Continue the other 
scheduled runs

Skip to Next Run 

To recover data from a stopped run, see 
“Recovering Data If Autoextraction Fails” on 
page 2-70.
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Continuous Runs

Running
Continuously

The continuous run feature allows you to create, import, and link a plate during a run. 
This feature gives you the capability of running one plate, removing the plate once 
samples have run, and then linking and running additional plates.

♦ Plates can only be mounted or unmounted when the instrument is paused.

♦ Plate records can be created before or after a pause.

♦ New plates are linked after a run has resumed.

Note The run scheduler re-initializes every time you use the plate editor to link or unlink a 
plate, create a new plate record, or edit an existing plate record. If you delete runs associated 
with a plate and then use the plate editor, the deleted runs will be rescheduled. Remove any 
unwanted runs in the Run View window.

Replacing a Plate in
Use

During a run, you can mount and unmount plates while the instrument is paused. The 
plate record can be created and then linked after the run has been resumed.

IMPORTANT Pausing the instrument for too long, especially after sample injection, will affect 
data quality. The best time to pause is before sample injection

To replace a plate that is currently in use: 

Step Action

1 Click Pause in the tool bar.

2 The following warning box displays.

a. Read the warning text.

b. Click OK to pause the instrument.

3 The following dialog box displays.

IMPORTANT Do not click OK, temporarily ignore the dialog box.

4 Remove the plate.

a. Press the Tray button to bring the autosampler forward.

b. Open the 3100 instrument door.

c. Remove the plate.

5 Mount the new plate.
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Using the Same Array for Sequencing and Fragment Analysis

Running Sequencing
and Fragment

Analysis Samples

The new ultra rapid sequencing module provides the opportunity to run sequencing 
and fragment analysis samples using the same 36-cm capillary array and POP-4 
polymer. Alternating runs of sequencing and fragment analysis samples does not 
affect the data quality.

6 Close the door.

The instrument resumes when the autosampler completes the initialization and 
returns to the home position.

7 If the 3100 instrument does not resume automatically, open and close the door 
again.

8 a. Click OK in the Paused completed dialog box.

The following message appears:

“Unlinking will cause current batch of runs to end after the current run finishes. 
Continue unlinking?”

b. Click OK to continue.

The following message appears:

“Current batch of runs will end after current run finishes.” 

d. Click OK.

9 Create a plate record and link the new plate.

10 Click Skip on the toolbar.

This stops the run from the plate that was removed but continues the remaining 
scheduled runs.

Note Any time you link or unlink a plate, the run scheduler re-initializes. If you 
delete run(s) associated with a plate and then link or unlink a plate, the deleted 
runs will be rescheduled. Remove any unwanted runs in the Run View window.

To replace a plate that is currently in use: (continued)

Step Action
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Section: Monitoring a Run

In This Section The following topics are covered in this section:

Introduction This section describes the functions and features of the:

♦ Data collection software views that are used to monitor a run 

♦ Instrument Status Monitor, which provides a summary of the current run 
conditions

Topic See Page

Run View Page 2-62

Status View Page 2-63

Array View Page 2-65

Capillary View Page 2-67

Instrument Status Monitor 2-68
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Run View Page

Function Click the Run View tab to monitor the status of the scheduled runs. 

Features This is an example of the Run View page.

Run Schedule Each row in the table provides information about a scheduled run. A run can be 
selected by single-clicking on a row.

Note Although you can delete individual runs, you cannot alter the order in which the runs are 
scheduled. For more information on run scheduling, see page 2-49.

Capillary Use
Indicator

This grid displays the capillaries in use during a run and the name of the sample that 
will be injected into a specific capillary.

Each cell in the grid represents a specific capillary. Once a run has started, the cells 
representing capillaries in use will turn blue. Position the pointer over an individual cell 
to display the name of the sample to be injected in that capillary.

Plate Image
Indicators

The plate images provide a visual representation of the physical sample layout for a 
selected run.

Delete Button The Delete button removes a run from the list of scheduled runs. First select the run in 
the Run Schedule window on the left, and then click the Delete button.

Note The Delete button does not delete the samples from the plate record. The samples can 
be run later, if desired.

Reservoir 
positions

Scheduled 
runs in order

Capillary 
use 
indicator

Delete 
button

Plate 
image
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Status View Page

Function Click the Status View tab to monitor the status of the instrument during a run.

Features This is an example of the Status View page.

Instrument
Condition Group

Box

The color of the box provides a quick way to check the status of the item to the right. 
See the table below for a definition of each color.

Events 
box

Errors 
box

Set value (defined in the selected run module) Actual value

Instrument 
Condition 
group box

Status bar

Array, polymer 
and # of runs 
information

For... A green box indicates...
A red box
indicates...

A yellow box 
indicates...

Laser Laser is off Laser is on Laser is idle

EP Electrophoresis is off Electrophoresis is on —

Oven Oven is off Oven is on —

Front Doors Doors are closed Doors are open —

Oven Door Door is closed Door is open —

Autosampler Autosampler is homed Autosampler is forward —
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Events Box The Events box lists the:

♦ Instrument’s recent actions

♦ Status of each capillary as passed or failed at the end of a spectral calibration 

♦ Calibration data at the end of a spatial calibration

Some of the events listed in the Events box provide information for service engineers.

Errors Box The Errors box lists errors that have occurred during the current run. 

Some of the error messages provide information for service engineers.  A “fatal” error 
usually requires that you restart the data collection software.

Status Bar The Status bar indicates the instrument’s current state or operation.
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Array View Page

Function Click the Array View tab during or after a run to examine the quality of your data, which 
is displayed as individual electropherograms and as color data for the entire capillary 
array.

IMPORTANT During a run, do not leave this page open for extended periods. This may cause 
unrecoverable screen update problems,

Features This is an example of the Array View page.

Fluorescence emission spectrum 
for the selected capillary

Capillary/color data 
display

Raw multicomponented 
electropherogram display for 
selected capillary

Use this scroll box 
to view data 
block-by-block.

Total intensity of collected 
signal for each capillary

Selected capillary to be 
displayed in the center plot
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Capillary/Color
Data Display

Each cell in the capillary/color data display represents one capillary. The status of that 
capillary is indicated by the color of the cell (see below).

Capillary Display During data collection, the capillary window displays the signal intensity by capillary 
number.

Fluorescence
Emission Spectrum

The fluorescence emission spectrum displays the real-time fluorescence emission 
spectrum of the dye-labeled fragments from the capillary selected. The spectrum is 
plotted against the CCD bin number instead of wavelength.

Note This window works only during data collection. This window is updated each time you 
select a different capillary in the Capillary Display window during data collection.

Electropherogram
Display

An electropherogram is a graph of relative dye concentration against time, plotted for 
each dye. The data displayed has been multicomponented. The relative dye 
concentration is determined by applying chemometric algorithms to the collected 
fluorescence data.

There are two plots for each dye. The plots represent the upper and lower confidence 
limits associated with the measured fluorescence intensity. 

Cell Color Status of the Capillary Comment

Green Operational Passed spectral calibration.

Yellow Failed Spectral This capillary did not pass the spectral calibration 
and has been assigned the spectral profile of its 
nearest passing neighbor.

There may be a problem with data collected from 
this capillary. 

Red Nonoperational All capillaries will have a red cell until a spatial 
calibration is performed.
2-66 Performing a Run



Total Intensity
Graph

The total intensity graph is a graph of the total intensity detected for each capillary.

Note This window works only during data collection. This window is updated each time you 
select a different capillary in the Capillary Display window during data collection. 

Capillary View Page

Function Click the Capillary View tab to examine the quality of electropherogram data for 
several capillaries at once.

IMPORTANT During a run, do not leave this page open for extended periods. This may cause 
unrecoverable screen update problems.

Features This is an example of the Capillary View page for a sequencing run.

Electropherogram 
displays 

Select check 
boxes of 
capillaries to 
be displayed
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Check Boxes Select the check boxes of the capillaries for which you want electropherograms 
displayed. The capillaries are displayed in the order in which the boxes are checked. 

Electropherogram
Displays

An electropherogram is a graph of relative dye concentration against time, plotted for 
each dye. The data displayed has been corrected for spectral overlap 
(multicomponented). The relative dye concentration is determined by applying 
chemometric algorithms to the collected fluorescence data.

There are two plots for each dye. The plots represent the upper and lower confidence 
limits associated with the measured fluorescence intensity. 

Instrument Status Monitor

Function The Instrument Status Monitor displays the current run conditions.

Viewing the
Instrument Status

Monitor

To view the Instrument Status Monitor:

Step Action

1 Select View > Instrument Status Monitor or double-click the Instrument Status 
Monitor button in the toolbar.

Note The Instrument Status Monitor can remain open while viewing other pages.
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Section: Working with Data

In This Section The following topics are covered in this section:

Topic See Page

Recovering Data If Autoextraction Fails 2-70

Viewing Raw Data from a Completed Run in the Data Collection Software 2-71

Viewing Analyzed Data 2-74
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Recovering Data If Autoextraction Fails

Overview Runs that are stopped before completion display the status Completed in the run table 
on the Run View page. 

The auto extractor software should automatically extract data from stopped runs. 
However, if autoextraction fails, use the Extractor utility as described below.

Selecting and
Queuing Runs for

Extraction

You can queue runs for extraction. This is especially useful for extracting failed runs or 
batches of runs.

To select and queue runs for extraction: 

Step Action

1 Ensure that the OrbixWeb Daemon and AEServer are running.

2 Quit the data collection software.

Note The Extractor utility and data collection cannot run simultaneously.

3 Select Start > Applied Biosystems > 3100-Avant Utilities > Extractor Utility.

4 Select a run or runs to extract.

Note Do not select runs with Not extractable status.

5 Click Extract.

The data will be extracted to the location defined in your preferences or the default 
location:

D:\AppliedBio\3100-Avant\Data Extractor\Extracted Runs
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Viewing Raw Data from a Completed Run in the Data Collection Software

Overview Raw data is data that has been multicomponented (corrected for spectral overlap) but 
mobility correction has not been applied. There are two formats for viewing the raw 
data within the data collection software: 

♦ In the Array View page (similar to the gel file output from an ABI PRISM slab gel 
instrument)

♦ In the Capillary View page, capillary-by-capillary

Note Only current run data can be viewed during a run; you cannot view data from previous 
runs while the instrument is running.

IMPORTANT Always exit from the Array View and the Capillary View windows. During a run, 
do not leave these pages open for extended periods. This may cause unrecoverable screen 
update problems. Leave the Status View window open.

Viewing Raw Data To view raw data from a completed run: 

Step Action

1 In the data collection software, click the Array View tab.

2 Select Instrument > Data Acquisition > Display Run Data. 

3 In the drop-down list, select the run that you want to display and click OK. 

Note You can view any completed run that remains in the instrument database. It 
may take a few moments to retrieve the data, especially if the database is getting 
full.
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4 Use the scroll features in the Array View page to view the data.

Note For information on the Array View page, see page 2-65.

5 Alternatively, to view electropherogram data from several capillaries at once, click 
the Capillary View tab to display the Capillary View page. 

Note For information on the Capillary View page, see page 2-67.

To view raw data from a completed run: (continued)

Step Action

Active 
during 
collection 
only
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Displaying an Entire
Run

To display an entire previous run (gel image): 

Step Action

1 Select Instrument > Data Acquisition > Display Entire Run. 

2 Select a gel image and click OK.

3 An example of the Entire Run Display box is shown below.

♦ To zoom in on the run display image, select an area of the image 
by dragging the pointer and click ZOOM.

♦ To return to the original image, click Return.

4 To close the run display, click OK.

Scan and capillary 
numbers

Data from an 
entire run
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Viewing Analyzed Data

Locating Sample
Files

When a run is finished, the analyzed sample files are extracted into a run folder, along 
with a run log, to a location defined in your preferences or the default location: 

D:\AppliedBio\3100-Avant\DataExtractor

An example of a run folder and its contents is shown below.

If the data has been re-extracted, the data is in the location defined in your 
preferences or the default location:

D:\AppliedBio\3100-Avant\Data Extractor\Extracted Runs

DNA Sequencing
Sample Files

After a run has been extracted to sample files, you can use the DNA Sequencing 
Analysis software to view the electropherogram data, both raw and analyzed. All 
sequencing sample files contain the .ab1 extension.

Refer to the ABI PRISM® DNA Sequencing Analysis Software v. 3.7 NT User Guide 
(P/N 4308924) for details on viewing and analyzing sequencing data. 

Fragment Analysis
Sample Files

After a run has been extracted to sample files, you can use the analysis software to 
view the electropherogram data, both raw and analyzed. All fragment analysis sample 
files contain the .fsa extension.

Refer to the ABI PRISM® GeneScan®Analysis Software v. 3.7 NT User Guide 
(P/N 4308923) for details on viewing and analyzing GeneScan data. 

Contents of the 
DataExtractor folder

Contents of a Run 
folder (sequencing 
samples)
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Spatial and Spectral 
Calibrations 3
In This Chapter The following topics are covered in this chapter:

Topic See Page

Calibrating the Instrument 3-2

Section: Spatial Calibration 3-3

About Spatial Calibration 3-4

Performing a Spatial Calibration 3-5

Displaying a Spatial Calibration Profile 3-9

Overriding the Current Spatial Calibration Map 3-10

Section: Spectral Calibration 3-13

About Spectral Calibrations 3-14

Preparing and Loading Spectral Calibration Standards 3-16

Performing a Spectral Calibration Using Default Processing Parameters 3-19

Displaying a Spectral Calibration Profile 3-27

Activating a Spectral Calibration for a Dye Set 3-31

Overriding a Spectral Calibration Profile 3-33
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Calibrating the Instrument

Required
Calibrations

A charge-coupled device (CCD) camera is used to collect the fluorescent signal as 
samples electrophorese through the detection cell. Before running samples on the 
ABI PRISM® 3100 Genetic Analyzer, the CCD must be calibrated in two dimensions:

♦ Spatial dimension (y-axis), which is used to detect each capillary position

♦ Spectral dimension (x-axis), which is used to detect the dyes

Figure 3-1 CCD camera with axes labeled
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Section: Spatial Calibration

In This Section The following topics describe how to perform a spatial calibration:

Topic See Page

About Spatial Calibration 3-4

Performing a Spatial Calibration 3-5

Displaying a Spatial Calibration Profile 3-9

Overriding the Current Spatial Calibration Map 3-10

Overriding the Current Spatial Calibration Map 3-10
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About Spatial Calibration 

What is a Spatial
Calibration?

The spatial calibration maps the position of each capillary detected on the CCD. 

Spatial calibration runs are 2 min long (6 min for capillary fill and spatial calibration 
run). During this time, multiple frames of data are collected and summed. The 
collected data is analyzed and saved as a spatial map.

When to Calibrate A spatial calibration must be performed whenever you install a new or used array on 
the instrument, or after you temporarily remove the capillary array from the detection 
block.

Spatial Maps Only one spatial map is stored in the instrument database on drive E. The term 
“current” spatial map refers to that spatial map. You can replace (override) the “current” 
spatial map with a spatial map stored in a spatial calibration file. For the procedure, 
see page 3-10.

Spatial calibration maps are stored as text files (.scl extension) in:

♦ D:\AppliedBio\3100-Avant\DataCollection\SpatialCalLogs

♦ 3100 Calibration file 

♦ Firmware

Calibration File Contents

Each spatial calibration file contains one spatial map from either the current or a 
previous calibration. 

Calibration File Naming Convention

Spatial calibration files have the following file name format:

SpatialCal-instrumentname-Rundate-time.scl

Spatial Calibration
Log Files

A spatial calibration log file is created during a spatial calibration. It contains a 
summary of the data collected during the spatial calibration run, including the pixel 
positions assigned to each capillary. 

The log file is a text file that can be opened and viewed in the Notepad accessory. It 
can be useful for troubleshooting spatial calibration problems.

The log file is stored in the same directory as the spatial calibration files with the 
following file name format: 

SpatialCal-instrumentname-Rundate-time.log
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Performing a Spatial Calibration

Performing a Spatial
Calibration

To perform a spatial calibration: 

Step Action

1 Select Tools > Perform Spatial Calibration. 

The following progress box displays:

2 Select the Fill capillaries check box if the capillaries have no polymer (i.e., a new 
capillary array, or the polymer in the capillaries has been used in a run). 

Note You need not fill the capillaries each time you perform a spatial calibration. 

3 Click Start. 

The calibration takes approximately:

♦ 2 min without filling the capillaries

♦ 6 min with filling the capillaries
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4 If the calibration... Then...

succeeded the following progress box opens:

a. Click Details to view the Spatial Calibration Profile 
window. 

b. Proceed to “Evaluating and Saving the Data” below.

failed an error message box opens, providing some information 
about the reason for the failure. 

a. Click Details to view the Spatial Calibration Profile 
window. 

b. Do one of the following:

– Click Cancel, and then click Start to repeat the 
calibration.

– Take corrective action as outlined on page 3-8.

To perform a spatial calibration: (continued)

Step Action
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Evaluating and
Saving the Data

To evaluate the spatial calibration results and save the data: 

Step Action

1 Evaluate the spatial calibration profile.

While viewing the calibration profile in the Details dialog box, use the following 
criteria to evaluate the data:

Peak Attribute Criteria

Height Similar heights for all peaks.

Red crosses One red cross marking the top of every peak. No misplaced 
crosses.

To move a cross: 

a. Change the value in a Capillary Position box. 

b. Click outside of that box. 

c. Click OK to accept the new value.

Shape ♦ Single sharp peak for each capillary.

♦ Small shoulders are acceptable.

Spacing Position values are 13–16 higher than the previous one for 
every capillary. Theoretical spacing between capillaries is 
15.
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If the Calibration
Fails

If the calibration fails, or if you do not like the appearance of the passed calibration 
profile, try one or more of the following corrective actions.

♦ Repeat the calibration.

♦ Fill the capillaries with polymer, and then repeat the calibration.

♦ Clean the detection cell, and then repeat the calibration (see page 4-14).

♦ Reposition the array window in the detection cell, and then repeat the calibration.

♦ Try another capillary array.

2

3 Click Yes to close the Perform Spatial Calibration window.

The data becomes the current spatial calibration and the data is saved to the 
instrument and database.

To evaluate the spatial calibration results and save the data: (continued)

Step Action

If the spatial calibration 
profile is... Then...

satisfactory Continue on to step 3.

unsatisfactory Perform one or more of the following:

♦ Click Cancel to close the Details box, and then 
click Start to repeat the calibration.

♦ Reposition one or more of the red crosses. To 
move a cross, change the value in the Capillary 
Position box, and then click outside of that box.

♦ Override the data with data from a previous run 
(see page 3-10).

If the calibration continues to provide unsatisfactory 
results, see “If the Calibration Fails” on page 3-8.
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Displaying a Spatial Calibration Profile

Introduction By performing the procedure below, you can display the spatial calibration profile for 
the current capillary array or the profile that was used for a previous run.

Note With this procedure, you can view spatial calibration data, but you cannot change which 
data is set as the current map.

Displaying a Spatial
Calibration Profile

 

To display a spatial calibration profile:

Step Action

1 Select Tools > Display Spatial Calibration.

2

Note For information about the profile, see “Overriding the Current Spatial 
Calibration Map” on page 3-10.

If you want to display 
the profile for... Then...

the current array Click Current Array.

The Spatial Calibration Profile box for the current 
calibration data opens. 

Note The title bar is now displayed as Current 
Spatial Calibrations.

a previous run a. Click Previous run.

b. Select the desired run in the Select the source to 
display dialog box.

c. Click OK.
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Overriding the Current Spatial Calibration Map

Introduction Once the spatial calibration run has completed and you have accepted it, the new 
spatial calibration map is stored in the instrument database and sent to the 
instrument. This current map will be used to process sample run data. 

If the run data is bad when using the current map, you can override the calibration 
data with:

♦ Data collected during a previous run on the same capillary array if the detection 
cell has not been moved

♦ A spatial calibration map used to process any previous sample run still stored in 
the database 

IMPORTANT Overriding calibration data is only allowed if the capillary array has not been 
removed and the detection cell has not been moved; Do not use calibration data collected from 
another capillary array.

Overriding the
Current Spatial

Calibration Profile

To override the current spatial calibration map: 

Step Action

1 Select File > Override Spatial Calibration. 

2 Select the spatial calibration file that you want to use and click OK.
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3 The Spatial Calibration Profile from the selected file opens.

4 The Question dialog box opens, click Yes. 

This data becomes the current spatial calibration map and the Spatial Calibration 
Profile from dialog box closes.

To override the current spatial calibration map: (continued)

Step Action

If the profile is… Then click…

acceptable OK

not acceptable Cancel

Repeat steps 1 and 2.
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Section: Spectral Calibration

In This Section The following topics are covered in this section:

Topic See Page

About Spectral Calibrations 3-14

Preparing and Loading Spectral Calibration Standards 3-16

Performing a Spectral Calibration Using Default Processing Parameters 3-19

Displaying a Spectral Calibration Profile 3-27

Activating a Spectral Calibration for a Dye Set 3-31

Overriding a Spectral Calibration Profile 3-33
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About Spectral Calibrations

Background Although the dyes in a dye set fluoresce at different wavelengths, there is some 
overlap in the emission spectra of the dyes used. This spectral overlap must be 
eliminated for proper data analysis.

A spectral calibration is a run that produces a mathematical description of the overlap 
in the emission spectra of a given dye set. This mathematical description is called a 
matrix, and is required for each capillary. The process of applying a matrix to sample 
data is called multicomponenting.

A separate matrix is required for each dye set.

Figure 3-2 The spectral profile for dye set Z.

What Happens? Spectral standards are run in all 16 capillaries. Then, the data collection software:

♦ Collects the data and stores it into 16 separate temporary files

♦ Analyzes the data and generates a mathematical description of the spectral 
overlap for each capillary

♦ Stores the data as a matrix

When to Calibrate You must perform a spectral calibration:

♦ Whenever you use a new dye set on the instrument.

♦ Whenever a service engineer realigns/replaces the laser, optics, or CCD camera

♦ If you begin to see a decrease in spectral separation (pull-up and/or pull-down 
peaks).

♦ For fragment analysis only, if you change capillary array lengths (see below)

Changing Capillary
Array Lengths

The impact of changing the capillary array length on spectral calibrations is different 
for sequencing and fragment analysis applications.

Analysis Application Impact

Sequencing analysis Typically, for each dye set, a single spectral calibration can be 
used for all capillary array lengths and polymer combinations.

Fragment analysis For each dye set, a separate spectral calibration must be used for 
the 22- and 36-cm capillary arrays. Refer to “Activating a Spectral 
Calibration for a Dye Set” on page 3-31, for information on how to 
switch calibrations.
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Procedure Overview The procedures for performing a spectral calibration are basically the same for 
fragment analysis and DNA sequencing analysis applications.

Performing a spectral calibration is similar to performing a sample run, except that 
matrix calibration standards are run in place of samples, and a spectral calibration run 
module is used in place of a fragment or sequencing analysis run module.

Part Description

Software 
setup

You will begin the procedure by preparing the instrument and calibration 
standards. Next, you will set up the run using the Plate View page of the data 
collection software. During the software setup, you will be prompted to select a 
specific:

♦ Spectral run module (determines the run conditions for each array type)

♦ Dye set (configures the software for the dye set you are using)

♦ Spectral parameter file (selects the type of algorithm you want to use to 
process the data: matrixStandard or sequenceStandard)

Standards 
calibration

During the calibration, dye-labeled DNA standards are electrophoresed, and 
the fluorescence data is collected and stored as temporary files. The matrix- 
making software analyzes this data and creates a spectral calibration matrix, 
which is used for sample data. Application of this matrix to the raw data is 
called multicomponenting.

Data 
analysis

After the calibration run, the software analyzes the matrices and assigns a 
capillary status value to each capillary. 

The matrix passes if it:

♦ Exhibits four or five distinct fluorescence emission maxima from dye sets 
with four or five dyes

♦ Meets the criteria specified in the selected spectral calibration parameter 
text file 

A passed matrix must be assigned to every capillary before a sample run can 
be performed. 

The software automatically replaces matrices for failed capillaries with matrices 
created from capillaries that passed. The replacements are made from the next 
nearest capillary, with the left side taking priority over the right side.

Even though the algorithm has passed a calibration matrix from a capillary, it 
does not mean that the calibration data should necessarily be used for sample 
data analysis. We recommend that you examine all four calibration matrices 
before electing to save and use them for sample data processing. 

Ideally, each capillary has its own passed matrix. If you see a matrix that you 
do not want to use, you can use the Override Spectral Calibration command to 
replace the matrix with one from a neighboring capillary.
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Preparing and Loading Spectral Calibration Standards

Determining the
Correct Dye Set and
Matrix Standard Set

Use the table below to determine the correct dye set and matrix standard set for the 
application you are using.

IMPORTANT Fragment Analysis: For optimal resolution, as in the case of fine mapping, 
Applied Biosystems recommends using the 36-cm capillary array. However, the 22-cm capillary 
array can be used to rapidly scan the genome when using markers less than 360 bp. Refer to 
ABI PRISM® 3100 22-cm Capillary Array for High Throughput Microsatellite and SNP 
Genotyping User Bulletin for more information. To select the appropriate capillary length for your 
application, refer to “Selecting a Capillary Array” on page 2-17.

DNA Sequencing:
Preparing the

Sequencing
Standard

Application or Kit Dye Set Matrix Standard Set

ABI PRISM® BigDye® Terminator v3.0 chemistry Z ABI PRISM® BigDye® 
v3.0 Matrix Standard

ABI PRISM® BigDye® 
v3.0 Terminator 

Sequencing Standard

ABI PRISM® BigDye® Terminator chemistry E DS-01

Custom oligos D DS-30 

♦ ABI PRISM® Mouse Mapping Set v1.0

♦ Custom oligos

D  DS-31
(DS-30 + VIC™ Matrix 
Standard)1

1. Replace the HEX™ matrix standard in DS-30 kit with the VIC matrix standard.

 ABI PRISM® SNaPshot™ Multiplex System E5 DS-02

♦ ABI PRISM® Linkage Mapping Set (LMS) v2.5

♦ Custom Oligos

G5 DS-33

To prepare the matrix standard for Dye Set Z spectral calibration:

Step Action

1 Resuspend a tube of ABI PRISM® BigDye® Terminator v3.0 Sequencing Standard 
with 170 µL of Hi-Di formamide. 

CHEMICAL HAZARD. Formamide is harmful if absorbed through 
the skin and may cause irritation to the eyes, skin, and respiratory tract. It may 
cause damage to the central nervous system and the male and female 
reproductive systems, and is a possible birth defect hazard. Please read the 
MSDS, and follow the handling instructions. Wear appropriate protective eyewear, 
clothing, and gloves.

2 Vortex thoroughly.

3 Spin the mixture briefly in a microcentrifuge.

4 Heat the standard tube at 95 °C for 5 min to denature the DNA. 

5 Place the tubes immediately on ice for 2 min.

WARNING!
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DNA Sequencing:
Preparing the Matrix

Standard

Preparing Matrix Standard for Other Dye Sets

To prepare other dye sets, follow the product insert instructions included in the matrix 
standard box.

Fragment Analysis:
Preparing the

Matrix Standard

To prepare the matrix standard for Dye Set Z spectral calibration:

Step Action

1 Mix thoroughly the ABI PRISM® BigDye® v3.0 Matrix Standard tube.

2 Spin the tube briefly in a microcentrifuge.

3 Prepare the BigDye v3.0 Matrix Standard for Dye Set Z by combining the following 
in a labeled 1.5-mL microcentrifuge tube:

CHEMICAL HAZARD. Formamide is harmful if absorbed through 
the skin and may cause irritation to the eyes, skin, and respiratory tract. It may 
cause damage to the central nervous system and the male and female 
reproductive systems, and is a possible birth defect hazard. Please read the 
MSDS, and follow the handling instructions. Wear appropriate protective eyewear, 
clothing, and gloves.

4 Vortex thoroughly.

5 Spin the mixture briefly in a microcentrifuge.

6 Heat the standard tube at 95 °C for 5 min to denature the DNA. 

7 Place the tubes immediately on ice for 2 min.

Reagent Volume (µL)

ABI PRISM BigDye v3.0 Matrix Standard 10

Hi-DiTM Formamide (P/N 4311320) 190

Final Volume 200

WARNING!

To prepare the matrix standards for Dye Set G5 spectral calibration: 

Step Action

1 Mix thoroughly a Matrix Standard Set DS-33 tube.

2 Spin the tube briefly in a microcentrifuge.

3 Prepare the Matrix Standard Set DS-33 for Dye Set G5 by combining the following 
in a labeled 1.5-mL microcentrifuge tube:

CHEMICAL HAZARD. Formamide is harmful if absorbed through 
the skin and may cause irritation to the eyes, skin, and respiratory tract. It may 
cause damage to the central nervous system and the male and female 
reproductive systems, and is a possible birth defect hazard. Please read the 
MSDS, and follow the handling instructions. Wear appropriate protective eyewear, 
clothing, and gloves.

4 Vortex thoroughly.

Reagent Volume (µL)

Matrix Standard Set DS-33 5

Hi-Di Formamide (P/N 4311320) 195

Final Volume 200

WARNING!
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Preparing Matrix Standard for Other Dye Sets

To prepare other dye sets, follow the product insert instructions included in the matrix 
standard box.

Loading the
Standards

5 Spin the mixture briefly in a microcentrifuge.

6 Heat the standard tube at 95 °C for 5 min to denature the DNA. 

7 Immediately place the tubes on ice for 2 min.

To prepare the matrix standards for Dye Set G5 spectral calibration: (continued)

Step Action

To load the standards: 

Step Action

1 Dispense 10 µL of the denatured standard into the appropriate plate as shown 
below:

♦ 96-well plate, load wells A1 through D1

♦ 384-well plate, load wells A1, C1, E1, and G1 

GR1315c

A

B

C

D

E

F

G

H

1 2 3 4 5 6 7 8 9 10 11 12

GR1316c
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B
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D
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F

G

H

I

J

K

L

M

N

O

P

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24
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Performing a Spectral Calibration Using Default Processing Parameters

Introduction Use the procedure below to perform a basic, “default” spectral calibration for DNA 
sequencing analysis or fragment analysis. 

Note Dye Set Z or G5 are used for screen shot examples.

Preparing the
Equipment

2 Tap down or centrifuge the plate so that each standard is positioned at the bottom 
of its well. Your samples should:

To load the standards: (continued)

Step Action

Look like this... Not look like this... Not look like this...

The sample is 
positioned correctly in 
the bottom of the well.

The sample lies on the 
side wall because the 
plate was not 
centrifuged.

An air bubble lies at the 
bottom of the well 
because the plate was 
not centrifuged with 
enough force or time.

To prepare the equipment and supplies:

Step Action

1 Power on the computer and the instrument.

2 Prepare the instrument for a run (see page 2-15).

3 Place the plate on the autosampler (see page 2-46).
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Creating a Plate
Record

To create a plate record for the denatured matrix standards: 

Step Action

1 In the Plate View page of the data collection software, click New.

2 In the Plate Editor dialog box:

a. Name the plate.

b. Select Spectral Calibration.

c. Select 96-Well or 384-Well.

d. Click Finish.

The Plate Editor spreadsheet opens.

3
If performing a… Then…

sequencing spectral run perform steps 4 and 5.

fragment analysis spectral run proceed to, and perform steps 6 and 7.
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4 For a sequencing spectral run, complete the Plate Editor spreadsheet for the wells 
you have loaded.

IMPORTANT Verify that the correct spectral parameter file has been selected for 
the type of dyes you are running. Selecting the incorrect parameter file will cause 
the spectral calibration to fail.

This creates a plate record for the calibration run in the database. After a few 
seconds, the entry for the plate record appears in the Pending Plate Records table 
of the Plate Setup page.

5 Proceed to “Linking the Plate” on page 3-24.

To create a plate record for the denatured matrix standards: (continued)

Step Action

For... Perform the following...

Dye Set Z and 

ABI PRISM BigDye v3.0 
Sequencing Standard

a. Type a name for the samples.

b. Select Dye Set Z.

c. Select the run module depending on your 
capillary array size:

– 36-cm: SpectSQ36_POP4DefaultModule

– 36-cm: Spect36_POP6DefaultModule

– 50-cm: Spect50_POP6DefaultModule

– 80-cm: Spect80_POP4DefaultModule

d. Select the spectral parameter file 
SeqStd{Sequencing-SetZ}.par.

e. Click OK.

Dye Set Z and

ABI PRISM BigDye v3.0 
Matrix Standard Set

a. Type a name for the samples.

b. Select Dye Set Z.

c. Select the run module depending on your 
capillary array size:

– 36-cm: SpectSQ36_POP4DefaultModule

– 36-cm: Spect36_POP6DefaultModule

– 50-cm: Spect50_POP6DefaultModule

– 80-cm: Spect80_POP4DefaultModule

d. Select the spectral parameter file 
MtxStd{Sequencing-SetZ}.par.

e. Click OK.

Dye Set E and

Matrix Standard Set DS-01

a. Type a name for the samples.

b. Select Dye Set E.

c. Select the run module depending on your 
capillary array size:

– 36-cm: SpectSQ36_POP4DefaultModule

– 36-cm: Spect36_POP6DefaultModule

– 50-cm: Spect50_POP6DefaultModule

– 80-cm: Spect80_POP4DefaultModule

d. Select the spectral parameter file 
MtxStd{Sequencing-SetE}.par.

e. Click OK.
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6 IMPORTANT To select the appropriate capillary length for your application, refer 
to “Selecting a Capillary Array” on page 2-17.

For a fragment analysis spectral run, complete the Plate Editor spreadsheet for the 
wells you have loaded.

.

To create a plate record for the denatured matrix standards: (continued)

Step Action

For... Perform the following...

Dye Set D and 

♦ Matrix Standard Set 
DS-30,

or 

♦ Matrix Standard DS-31 
(Matrix Standard Set 
DS-30 + VIC Matrix 
Standard)

a. Type a name for the samples.

b. Select Dye Set D.

c. Select the run module depending on your 
capillary array size:

– 22 cm: Spect22_POP4DefaultModule

– 36-cm: Spect36_POP4DefaultModule

d. Select the spectral parameter 
MtxStd{GeneScan-SetD}.par.

e. Click OK.

Dye Set E5 and

Matrix Standard Set DS-02

a. Type a name for the samples.

b. Select Dye Set E5.

c. Select the run module depending on your 
capillary array size:

– 22 cm: Spect22_POP4DefaultModule

– 36-cm: Spect36_POP4DefaultModule

d. Select the spectral parameter 
MtxStd{GeneScan-SetE5}.par.

e. Click OK.
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6 
cont’d

IMPORTANT Verify that the correct spectral parameter file has been selected for 
the type of dyes you are running. Selecting the incorrect parameter file will cause 
the spectral calibration to fail.

This creates a plate record for the calibration run in the database. After a few 
seconds, the entry for the plate record appears in the Pending Plate Records table 
of the Plate View page.

7 Proceed to “Linking the Plate” on page 3-24.

To create a plate record for the denatured matrix standards: (continued)

Step Action

For... Perform the following...

Dye Set G5

Matrix Standard Set DS-33 

a. Type a name for the samples.

b. Select Dye Set G5.

c. Select the run module depending on your 
capillary array size:

– 22 cm: Spect22_POP4DefaultModule 

– 36-cm: Spect36_POP4DefaultModule

– 36-cm: Spect36vb_POP4DefaultModule

Note To select the appropriate capillary 
length for your application, refer to “Selecting a 
Capillary Array” on page 2-17.

d. Select the spectral parameter 
MtxStd{GeneScan-SetG5}.par.

e. Click OK.
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Linking the Plate

Starting the
Calibration

To link the plate record to the plate:

Step Action

1 In the Pending Plate Records table, select the plate record that you just created. 

2 Click the plate graphic that corresponds to the plate on the autosampler.

Note When a plate is linked, the:

– Plate graphic changes from yellow to green. 

– Plate record moves from the Pending Plate Records table to the Linked Plate 
Records table. (This may take up to 30 sec.)

– The Run Instrument button in the toolbar is enabled, meaning that the 
instrument is ready to run. If the autosampler is in motion, wait until it stops in 
the home position before starting the run.

To start the calibration: 

Step Action

1 If you want to review the run schedule before beginning the run, click the Run View 
tab.

2 Click the Run Instrument button in the toolbar to begin the run.
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Run Times

Spectral Calibration
Result Box

At the end of the run, while the data is being analyzed, the Spectral Calibration Result 
dialog box opens to indicate which capillaries have passed and which have failed.

The example below for Dye Set G5 shows four passing capillaries, which are 
represented by a “.” dot. A failed capillary is represented by an “X”.

To acknowledge the completed calibration run:

IMPORTANT Review and evaluate the spectral calibration profile for each capillary, even if the 
Spectral Calibration Results box indicated that they all passed. See “Displaying a Spectral 
Calibration Profile” on page 3-27.

Error Message for
Dye Set F or G5

The matrix-making algorithm has minimum peak requirements to create matrices for 
dye sets F and G5. The following message will display if peak amplitude falls below 
750:

Data Error - One or more peaks fall below the minimum required amplitude of 750

If this error message occurs, rerun the spectral standards, and if necessary, increase 
the amount.

The following table lists the spectral calibration run times: 

Application or Run Type
Capillary Array Length 

(cm)
Approximate Run Time 

(min)

SNP analysis 22 15

Microsatellite analysis 22 20

Microsatellite analysis 36 45

SNP analysis 36 30

Ultra rapid sequencing 36 40

Rapid sequencing 36 40

Standard sequencing 50 65

Long read sequencing 80 80

Step Action

1 In the Spectral Calibration Result dialog box, click OK.

Passed capillary (.)
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When a Capillary
Fails

If a capillary fails, it is automatically assigned the spectral profile of its nearest passing 
capillary to the left. If there are no passing capillaries to the left, it will be assigned the 
profile of the nearest passing capillary to the right. These capillaries are marked 
yellow instead of green in the Array View (e.g., “Array View Page” on page 2-65). 

For applications where pull-up and pull-down peaks will cause critical errors, we 
recommend that you repeat the spectral calibration and use a unique spectral for each 
capillary.

When the
Calibration Fails

If the spectral calibration failed, or if you do not like the appearance of the passed 
calibration, try one or more of the following:

♦ Verify that the correct parameter file and run module were selected. If not, correct, 
and then repeat the run.

♦ Verify the freshness of the reagents used.

♦ Verify that all peaks were detected. A slow running system can result in the blue 
peak being partially or totally cut off. Add time to the run, or change the reagents if 
they are suspect, and then repeat the run.
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Displaying a Spectral Calibration Profile

Introduction At any time, you can display the:

♦ Current spectral calibration profile for a specified dye set. The current profile is the 
one that was created when the last spectral calibration was performed and which 
is stored in the instrument database. The current profiles can be examined only if 
a spectral calibration has been performed for this dye set.

♦ Spectral calibration profiles used to process any of the runs currently stored in the 
instrument database.

Examining a
Spectral Calibration
Profile for a Dye Set

To display a current spectral calibration profile stored for a dye set: 

Step Action

1 Select Tools > Display Spectral Calibration.

2 The Question dialog box displays.

Click Dye set. 

3 This opens the Select the source to display dialog box.

In the drop-down list, select the dye set for the spectral calibration that you want to 
examine. For example, dye set Z will be used.

Drop-down list of 
dye sets
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4 Click OK. The Matrices for dye set box opens.

5 Use the arrow buttons or the slider to review the data for each capillary.

For a good-quality calibration, each capillary should have a:

♦ Q-value above 0.95 

♦ Condition number within range

To display a current spectral calibration profile stored for a dye set: (continued)

Step Action

Dye Set Condition Number Range

D 4 to 7

E 3 to 5

E5 2.5 to 4

G5 7 to 12

Z 3 to 5
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G5 Profiles Using the
G5vb Module

The SpectG5vb_POP4Default Module supports specific fragment analysis 
applications using G5 chemistry. The spectral profile is significantly different than all 
other dye sets. The profile contains multiple peaks per dye color, this is normal.

Figure 3-3 Spectral profile and raw data for a G5vb spectral calibration

6 For a closer view: 

a. Shift-click-drag the pointer to create a box around the area of interest.

b. Release the pointer. The expanded view is displayed.

c. To reset the view, press R.

7 Click Cancel to close the dialog box.

To display a current spectral calibration profile stored for a dye set: (continued)

Step Action

Spectral profile: 
multiple peaks per dye 
color

Raw data: 
single peak per dye 
color
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Examining Profiles
Used for Previous

Runs

To examine the matrices used to process a previous run: 

Step Action

1 Select Tools > Display Spectral Calibration. 

The Question box opens.

2 Click Previous run. 

3 In the drop-down list, select the profile to display and click OK.

Note Dye set G5 is used in this example.

4 The spectral file opens.

Use the slider bar to examine each capillary.

5 When finished examining the data, click Cancel.
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Activating a Spectral Calibration for a Dye Set

Introduction If you want to use a different spectral calibration for a specific dye set and/or capillary 
array length, you can select the active spectral calibration for a dye set from any 
previous spectral calibration runs. 

This is useful for: 

♦ Fragment analysis applications that require a separate spectral calibration (for the 
same dye set) for different capillary array lengths

♦ Applications that require different spectral calibrations for the same dye sets

♦ Repeat spectral calibrations where the original calibration is better than the 
second one

Activating a
Previous Calibration

To activate a specific spectral calibration: 

Step Action

1 Select Tools > Set Active Spectral Calibration.

2 Use the drop-down list to select the desired dye set and click OK.

Note If the dye set you select has not yet been calibrated, an alert box displays. 
Press OK and select another dye set.

3 A list of spectral calibrations for the selected dye set opens.

Select a calibration run and click Details to display the spectral matrix for review.
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About the Raw Data
Display

The data collection software stores the raw spectral data from a spectral calibration in 
temporary files. The temporary files are separated by dye set, and stored in the 
following location:

D:\AppliedBio\3100-Avant\DataCollection\SpectralCalLogs\CapRawData

There is only one copy of raw data per dye set. When a new spectral calibration is 
performed for an existing dye set, the current raw data is automatically replaced by the 
new raw data. 

When viewing previous spectral calibrations, the spectral profile displayed is from the 
run you selected.The raw data view is from the most recent calibration (original data 
was replaced). The correct matrix is applied to the data.

4 The Set Active Spectral dialog box opens.

a. Verify the spectral data.

b. Optional: In the Details window you can rename the spectral calibration file (up 
to 16 characters) and click Set Matrix Name. 

Note The Set Matrix Name button only saves the name of the spectral file.

The new name will be stored in a file called “sc.properties” in the main Bin 
directory. 

Close the window. The Set Active Spectral Calibration opens again.

5 Select the run to use and click OK.

To activate a specific spectral calibration: (continued)

Step Action

Change the name of 
the spectral file here
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Overriding a Spectral Calibration Profile

Introduction You can override unsatisfactory spectral calibration profiles in the data collection 
software. The profiles can be overridden for individual capillaries (one at a time) or for 
all capillaries at once. However, we do not recommend applying a matrix from a single 
capillary to capillaries more than two positions over.

You can override a profile with a good-quality profile that was collected either:

♦ From another capillary during the same calibration run (stored as .tmp files), or

♦ From previously collected data, after the capillary array was last moved or 
replaced (stored in the spectral calibration folder as .mcl files)

Overriding with
Data from Another

Capillary

Note To ensure the highest quality data, Applied Biosystems recommends that you do not 
override capillary profiles.

To override a spectral calibration profile with data from another capillary: 

Step Action

1 Select File > Override Spectral Calibration.

2 The Select the dye set to display dialog box displays.

a. Use the drop-down list to select the desired dye set. 

b. Click OK.

Note This example uses Dye Set Z.

3 The current spectral profile opens.

a. Use the slider bar to select the capillary to be overridden. (Capillary 3 is selected 
for this example.)

b. Click From capillary.
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4 a. Use the slider bar to select the source capillary to override the unsatisfactory 
profile. In this example, capillary 3 data will be overridden with capillary 4 data.

b. Click Override cap.

5 Confirm that the correct capillary appears next to Capillary Number, and click OK.

Note In the example, capillary 3 contained poor spectral data and capillary 4 
contained good spectral data. The raw data for the poor spectral is not updated in 
the raw data view.

To override a spectral calibration profile with data from another capillary: (continued)

Step Action

Spectral 
profile of 
capillary 4

Raw data 
from 
capillary 4

C number 
and Q value 
from 
capillary 4

Data used from capillary 4
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Overriding with
Previously Collected

Data

To override a spectral calibration profile with previously collected data: 

Step Action

1 Select File > Override Spectral Calibration.

2 The Select the dye set to display dialog box displays.

a. Use the drop-down list to select the desired dye set. 

b. Click OK.

Note In this example, dye set G5 will be used.

3 The current spectral profile is displayed.

a. Use the slider bar to select the capillary with the profile to be overridden.

b. Click From data file.

4 a. Locate and double-click the spectral source file folder.

b. Select a capillary .mcl to override the unsatisfactory profile, and click OK.
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5 In the Use the matrix from file dialog box, confirm that the correct file appears next 
to Data Source: From file: Cap#.mcl and Click Override cap.

6 Confirm that the correct capillary appears next to Capillary Number, and click OK.

Note In the example, capillary 1 contained poor spectral data and the .mcl file of 
capillary 2 contained good spectral data. The raw data for the poor spectral is not 
updated in the raw data view.

To override a spectral calibration profile with previously collected data: (continued)

Step Action

Spectral 
profile of 
cap02.mcl 
file

Raw data 
from 
capillary 1

C number 
and Q value 
from 
cap02.mcl 
file

Spectral profile used for cap02.mcl 
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4
Maintenance 4
In This Chapter The following topics are covered in this chapter:

Topic See Page

Section: Instrument Maintenance 4-3

Maintenance Task Lists 4-4

Routine Cleaning 4-5

Moving and Leveling the Instrument 4-6

Resetting the Instrument 4-7

Shutting Down the Instrument 4-8

Section: Fluids and Waste 4-9

Buffer 4-10

Polymer 4-10

Instrument Waste 4-11

Section: Capillary Array 4-13

Before Installing a Previously Used Capillary Array 4-14

Installing and Removing the Capillary Array 4-15

Capillary Array Maintenance 4-17

Storing a Capillary Array on the Instrument 4-18

Storing a Capillary Array off the Instrument 4-19

Section: Syringes 4-21

Syringe Maintenance 4-22

Priming and Filling Syringes 4-24

Installing and Removing Syringes 4-25

Section: Polymer Blocks 4-27

Removing the Polymer Blocks 4-28

Cleaning the Polymer Blocks 4-29

Removing Air Bubbles from the Upper Polymer Block 4-32

Section: Autosampler Calibration 4-33

Section: Checking the Available Space and Deleting Records 4-35

Checking the Available Hard Drive Space 4-36

Archiving Data 4-37

Checking the Available Database Space 4-39

Deleting Records from the Database 4-39
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Section: Instrument Maintenance

In This Section The following topics are covered in this section:

Topic See Page

Maintenance Task Lists 4-4

Routine Cleaning 4-5

Moving and Leveling the Instrument 4-6

Resetting the Instrument 4-7

Shutting Down the Instrument 4-8
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Maintenance Task Lists

Overview This section lists common tasks required to maintain your ABI PRISM® 3100-Avant 
Genetic Analyzer in good working condition. The tasks are divided into tables based 
on how often you should perform each task.

IMPORTANT Wear gloves any time you handle the capillary array, glass syringes, septa, or 
buffer reservoirs.

Daily Tasks

Weekly Tasks

Perform these tasks at least once per day.

Maintenance Task Frequency See Page

Ensure that the reservoir septa are firmly seated and flat. Before each run —

Ensure that the plate assembly were put together 
properly. 

IMPORTANT The holes in the plate retainer must align 
with the holes in the septa or the capillary tips will be 
damaged.

Before each run 2-45

Ensure that the plate assembly is positioned on the plate 
deck properly. Plate should sit snugly on the deck. 

IMPORTANT Never use warped plates.

Before each run —

Replenish the water and 1X running buffer reservoirs on 
the instrument.

Daily or before 
each run

2-19

Check for bubbles in the polymer block and polymer block 
channels and remove.

Daily or before 
each run

4-32

Check the loading-end header to ensure the capillary tips 
are not crushed or damaged.

Daily or before 
each run

—

Check the level of polymer in the polymer-reserve syringe 
to ensure there is at least 1 mL.

Daily or before 
each run

—

Check the polymer block to ensure it fits securely on the 
instrument.

Daily —

Clean the instrument surfaces. Daily 4-5

Check for dried polymer around the polymer block and 
clean as necessary.

Daily —

Check for leaks around the syringes and screw nut. Daily —

Check data base space. Delete plate records from the 
instrument database and archive sample files.

Daily 4-35

Perform these tasks at least once per week.

Maintenance Task Frequency See Page

Clean the syringes. Weekly or as 
needed

4-22

Clean the water and buffer reservoirs with warm water. Weekly —

Clean the upper and lower polymer blocks. Weekly 4-29

Replace the polymer in the syringes, upper polymer block, 
and capillary array.

Weekly or as 
needed

4-10

Check the storage conditions of the used arrays. Weekly —
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As-Needed Tasks

Routine Cleaning

General Cleaning

Perform these tasks as needed.

Maintenance Task Frequency See Page

Clean the drip trays. As needed —

Change the array. As needed 4-15

Replace syringes 3 months —

Remove any dried polymer from the capillary tips. Use a 
lint-free wipe moistened with deionized water.

As needed —

Calibrate the autosampler Very rarely 4-33

To clean the instrument:

Step Action

1 Press the Tray button on the front of the instrument to move the autosampler to the 
forward position.

2 Wipe off any liquid on or around the autosampler using a lint-free tissue.

3 Clean out the drip trays with deionized water and lint-free tissue.

4 Clean off any polymer build-up (crystals) on the instrument including the capillary 
tips and the stripper plate with deionized water and lint-free tissue. 

IMPORTANT Never use organic solvents to clean the instrument.
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Moving and Leveling the Instrument

Before Moving the
Instrument

PHYSICAL INJURY HAZARD. Do not attempt to lift the instrument or any 
other heavy objects unless you have received related training. Incorrect lifting can cause painful 
and sometimes permanent back injury. Use proper lifting techniques when lifting or moving the 
instrument. Two or three people are required to lift the instrument, depending upon instrument 
weight.

Leveling the
Instrument

To prepare for moving the instrument:

Step Action

1 Remove the following components from the instrument:

♦ Any plate assemblies from the autosampler.

♦ Water and buffer reservoirs from the autosampler.

♦ Capillary array. For instruction see page 4-15.

♦ Syringes from the upper polymer block. For instruction see page 4-25.

♦ Upper polymer block. For instruction see page 4-28.

♦ Anode buffer reservoir.

♦ Lower polymer block. For instruction see page 4-28.

2 Switch off the breaker on the back of the instrument. 

3 Disconnect the power cord and the Ethernet cable.

4 While moving the instrument, avoid any shock or vibration.

WARNING!

To level the instrument:

Step Action

1 Place the bubble level on the autosampler deck.

2 Turn the instrument legs to level the instrument.

To move the instrument corner... Turn the leg...

up right (clockwise)

down left (counterclockwise)
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Resetting the Instrument 

Overview Reset the instrument when:

♦ There is a fatal error as indicated by the red status light

♦ The instrument does not respond to the ABI PRISM® 3100-Avant Data Collection 
software

There are two ways to reset the instrument: 

♦ Press the Reset button on the front of the instrument to dump and reload the 
firmware and to reset the electronics. Try this method first.

♦ Shut down and restart the computer and the instrument. 

Resetting With the
Reset Button

Resetting by
Powering Down

To reset the instrument:

Step Action

1 Close the instrument doors.

2 Using a long narrow implement, such as a straightened paper clip, press the Reset 
button on the front of the instrument.

Reset button

To reset the instrument:

Step Action

1 Close the instrument doors.

2 Turn off the instrument by pressing the On/Off button on the front of the instrument.

3 Restart the computer.

a. Select Start > Shutdown.

b. In the Shutdown Windows dialog box, select Restart and click OK.

IMPORTANT Wait until the computer has completely restarted before proceeding.

4 Turn on the instrument and wait for the solid green light.

Note When the instrument is shut down, the firmware is not saved. Upon restart, 
the instrument will reload a copy of the firmware and the calibration file from the 
computer.

5 Open the data collection software.
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Shutting Down the Instrument

Short- and
Long-Term
Shutdowns

Perform the appropriate shutdown procedure as follows:

Performing a
Short-Term

Shutdown

Performing a
Long-Term

Shutdown

If the instrument will be 
unattended for... Perform this shutdown procedure...

no more than 1 week with 
a full buffer reservoir

Short-term

IMPORTANT The key to a successful short-term shutdown is 
keeping the capillary array in 1X running buffer. This prevents 
the polymer from drying in the capillaries.

for more than 1 week Long-term

To perform a short-term shutdown:

Step Action

1 Fill the capillaries with fresh polymer. For instructions, see page 4-18.

2 Push the Tray button to move the autosampler forward.

3 Fill the buffer reservoir with 1X running buffer to just below the top of the reservoir.

4 Fill other reservoirs with fresh deionized water.

5 Secure a septa onto the reservoir and place the reservoir in position 1 on the 
autosampler. 

6 Close the instrument doors. The autosampler will move to position 1, leaving the 
capillary tips in the buffer reservoir.

7 Shut down the computer and turn off the instrument.

To perform a long-term shutdown:  

Step Action

1 Follow the procedure on page 4-19 to remove and store the capillary array off the 
instrument.

2 Remove from the instrument:

♦ Syringes from the upper polymer block. For instructions see page 4-25.

♦ Upper polymer block. For instructions see page 4-28.

♦ Lower polymer block. For instructions see page 4-28.

3 Remove from the autosampler:

♦ Plate assembly

♦ Reservoirs

4 Wipe the autosampler and drip trays with lint-free tissue dampened with water.

5 Close the instrument doors.

6 Shut down the computer and turn off the instrument.

7 Wash the syringes, polymer blocks, and reservoirs with warm water. Rinse with 
deionized water.

IMPORTANT Make sure all parts are completely dry before long-term storage.
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Section: Fluids and Waste

In This Section The following topics are covered in this section:

Topic See Page

Buffer 4-10

Polymer 4-10

Instrument Waste 4-11
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Buffer

When to Change the
Buffer

We recommend that you change the buffer before each run or at least every 
24 hours.

Making Buffer for a
Single Run

CHEMICAL HAZARD. 10X Genetic Analyzer Buffer with EDTA may cause 
eye, skin, and respiratory tract irritation. Read the MSDS, and follow the handling instructions. 
Wear appropriate protective eyewear, clothing, and gloves.

Storing Buffer The 1X running buffer can be stored at 2 to 8 °C for up to 1 month.

Polymer

Storing Polymer Store any remaining ABI PRISM® 3100 POP™ polymer at 2 to 8 °C until the expiration 
date printed on the jar. 

Note Excessively hot environments may shorten the working life of the polymer.

When to Change the
Polymer

We recommend that you change the polymer weekly. The polymer is good at 25 °C 
for about 7 days.

Adding and
Changing the

Polymer

CHEMICAL HAZARD. POP polymers may cause eye, skin, and respiratory 
tract irritation. Read the MSDS for the polymer you are using, and follow the handling 
instructions. Wear appropriate protective eyewear, clothing, and gloves. Use for research and 
development purposes only.

To prepare 50 mL of 1X running buffer:

Step Action

1 Add 5 mL of 10X Genetic Analysis Buffer into a graduated cylinder.

2 Add deionized water to bring the total volume up to 50 mL.

3 Mix well.

CAUTION!

To put fresh polymer on the instrument: 

Step Action

1 Select Tools > Change Polymer Wizard.

2 Follow the directions given in the wizard to put fresh polymer on the instrument.
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Instrument Waste

Chemical Waste
Hazard Warning

CHEMICAL WASTE HAZARD. Wastes produced by Applied Biosystems 
instruments are potentially hazardous and can cause injury, illness, or death.

♦ Read and understand the material safety data sheets (MSDSs) provided by the 
manufacturers of the chemicals in the waste container before you store, handle, or 
dispose of chemical waste.

♦ Minimize contact with chemicals. Wear appropriate personal protective equipment 
when handling chemicals (e.g., safety glasses, gloves, or protective clothing). For 
additional safety guidelines, consult the MSDS.

♦ Minimize the inhalation of chemicals. Do not leave chemical containers open. Use 
only with adequate ventilation (e.g., fume hood). For additional safety guidelines, 
consult the MSDS.

♦ Handle chemical wastes in a fume hood.

♦ After emptying the waste container, seal it with the cap provided.

♦ Dispose of the contents of the waste tray and waste bottle in accordance with 
good laboratory practices and local, state/provincial, or national environmental 
and health regulations.
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Section: Capillary Array

In This Section The following topics are covered in this section:

Topic See Page

Before Installing a Previously Used Capillary Array 4-14

Installing and Removing the Capillary Array 4-15

Capillary Array Maintenance 4-17

Storing a Capillary Array on the Instrument 4-18

Storing a Capillary Array off the Instrument 4-19
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Before Installing a Previously Used Capillary Array

Introduction Before you reinstall a capillary array, it is recommended that you:

♦ Clean the front of the detection cell

♦ Check that the cathode bar is dry

Cleaning the
Detection Cell

This procedure is unnecessary for new arrays unless you have accidently touched the 
detection cell.

Checking the
Cathode Bar

When putting a used array back on the instrument, be sure that the cathode bar is dry. 
A wet bar could lead to arcing. 

ELECTRICAL SHOCK/FIRE HAZARD. Do not leave liquid in the cathode bar. 
This can lead to electric shock or even fire if not properly maintained.

To clean the detection cell:

Step Action

1 Put one drop of methanol on the front surface of the detection cell. 

CHEMICAL HAZARD. Methanol is a flammable liquid and vapor. 
Exposure may cause eye, skin, and respiratory tract irritation, and central nervous 
system depression and blindness. Please read the MSDS, and follow the handling 
instructions. Wear appropriate protective eyewear, clothing, and gloves

2 Use short, gentle bursts of clean pressurized air to dry the cell. 

GR2144

Front surface of detection cell

WARNING!
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cathode bar is 
dry—especially 
in the center
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Installing and Removing the Capillary Array

When to Change a
Capillary Array

A capillary array should last approximately 100 runs. 

The following problems may indicate that a new capillary array is required: 

♦ Poor sizing precision or allele calling

♦ Poor resolution and/or decreased signal intensity

Installing or
Removing the

Capillary Array
Using the Wizard

IMPORTANT Wear gloves while performing the following procedure, and any other time you 
handle the capillary array, glass syringes, septa, or buffer reservoirs.

CHEMICAL HAZARD. POP polymer may cause eye, skin, and respiratory tract 
irritation. Please read the MSDS, and follow the handling instructions. Wear appropriate 
protective eyewear, clothing, and gloves. Use for research and development purposes only.

To replace a capillary array or to install a capillary array on an instrument: 

Step Action

1 Close the oven and instrument doors, and then press the Tray button.

2 Select Tools > Install Capillary Array Wizard.

The wizard opens.

3 Follow the directions given in the wizard to replace or install an array.

CAUTION!
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Installing the
Capillary Array

Without Using the
Install Wizard

IMPORTANT Wear gloves while performing the following procedure, and any other time you 
handle the capillary array, glass syringes, septa, or buffer reservoirs.

CHEMICAL HAZARD. POP polymer may cause eye, skin, and respiratory tract 
irritation. Please read the MSDS, and follow the handling instructions. Wear appropriate 
protective eyewear, clothing, and gloves. Use for research and development purposes only.

To install a capillary array on an instrument: 

Step Action

1 Close the oven and instrument doors, and then press the Tray button.

2 Install the capillary array.

3 Select Tools > Update Capillary Array Info.

The following dialog box opens.

4 Complete the dialog box using your capillary array information and click OK.

CAUTION!
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Capillary Array Maintenance

Caring for the
Capillary Array

Follow these guidelines to properly care for the capillary array:

♦ Wear gloves and handle the capillary array gently.

♦ Do not touch the detection cell. If it is dirty, see “Cleaning the Detection Cell” on 
page 4-14.

♦ Keep the ends of the capillary array wet at all times.

♦ Always loosen the capillary array nut before pulling out the upper polymer block.

♦ Do not overtighten the capillary array nut.

Cleaning the
Capillary Array

CHEMICAL HAZARD. POP polymer may cause eye, skin, and respiratory tract 
irritation. Please read the MSDS, and follow the handling instructions. Wear appropriate 
protective eyewear, clothing, and gloves. Use for research and development purposes only.

To clean the capillary array:

Step Action

1 Flush the capillary array with fresh polymer as instructed in the “Installing and 
Removing the Capillary Array” on page 4-15.

2 Clean off any polymer buildup (crystals) on the instrument, including the capillary 
electrodes and the stripper plate, with deionized water and lint-free tissue. 

Note When cleaning the capillary electrodes, be careful not to bend them out of 
position. If the electrodes do get bent, follow the procedure “Verifying Capillary 
Alignment Using the Capillary Ruler” below. 

IMPORTANT Never use organic solvents to clean the instrument.

3 Clean the detection cell as instructed on page 4-14.

CAUTION!
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Filling the Capillary
Array with Polymer

Using Manual
Control

Verifying Capillary
Alignment Using the

Capillary Ruler

Storing a Capillary Array on the Instrument

Overview Store the capillary array on the instrument when the capillary array will be unused for 
less than 1 week.

Storing the Array on
the Instrument

To store the capillary array on the instrument, follow the instructions to perform a 
short-term shutdown on page 4-8. 

To fill the capillary array with polymer using manual control commands: 

Step Action

1 Select Instrument > Manual Control.

2 In the Command Category drop-down list, select Capillary.

3 In the Command Name drop-down list, select Fill.

4 In the Value drop-down list, select the appropriate array length and polymer.

5 Click Send Command.

Wait until you see the message Command complete before continuing.

To check capillary alignment using the capillary ruler:

Step Action

1 Place the ruler beside the capillaries and detach a side of the ruler to the bottom of 
the holder.

2 Verify that the capillaries match the lines of the ruler.

3 Check both sides of the capillaries.

4 Place the capillary array holder on the flat surface and stand the ruler up at the end 
of capillaries.

5 Verify that the cross points of line on the ruler to match the end of capillaries. If 
some of capillaries are bent, adjust each capillary carefully.
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Storing a Capillary Array off the Instrument

Overview Store the capillary array off of the instrument when the capillary array will be unused 
for longer than 1 week.

Before storing the capillary array for long periods, we recommend filling the capillaries 
with fresh polymer.

Storing the
Capillary Array off

the Instrument

CHEMICAL HAZARD. POP polymer may cause eye, skin, and 
respiratory tract irritation. Please read the MSDS, and follow the handling instructions. 
Wear appropriate protective eyewear, clothing, and gloves. Use for research and 
development purposes only.

IMPORTANT Wear gloves while performing the following procedure, and any other time you 
handle the capillary array, glass syringes, septa, or buffer reservoirs.

To store the capillary array off the instrument: 

Step Action

1 Fill the capillary array with fresh polymer using the Change Polymer wizard or 
manual control commands.

2 Remove the syringe guard.

3 Remove both syringes from the upper polymer block and properly dispose of any 
remaining polymer.

4 Wash the syringes.

5 Remove the capillary array from the instrument using the Install/Replace Capillary 
Array wizard.

For instructions see, “Installing and Removing the Capillary Array” on page 4-15. 

6 Replace the cover over the detection cell.

7 Fill a buffer reservoir with fresh 1X running buffer and cover with a septa strip. Insert 
the capillary tips into the buffer.

8 Fill the shipping vial with fresh 1X running buffer and insert the detection end of the 
capillary array. 

9 Store the capillary array upright. 

10 Check the 1X running buffer level in the reservoir and tube weekly.

CAUTION!
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Section: Syringes

In This Section The following topics are covered in this section:

Topic See Page

Syringe Maintenance 4-22

Priming and Filling Syringes 4-24

Installing and Removing Syringes 4-25
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Syringe Maintenance

Syringe Types The following table lists the name, volume, and function of the two syringes:

Caring for Syringes IMPORTANT To extend the lifetime of the syringe plunger’s Teflon fitting, do not insert a dry 
plunger into the barrel of the syringe. Place a small drop of deionized water on the plunger’s end 
before inserting it into the syringe. Pump the plunger slowly.

IMPORTANT Do not mix the barrels and plungers from different syringes. Mixing and 
matching is a common cause of leaks.

IMPORTANT Wear gloves while handling the glass syringes.

Replacing the
Syringes

To maintain optimal performance, we recommend that you replace syringes about 
every 3 months.

Cleaning Syringes Clean the syringes thoroughly:

♦ Whenever they are removed from the instrument, or at least once per week

♦ Each time the polymer is replaced, including when switching to a new type or lot of 
polymer

IMPORTANT Wear gloves while performing the following procedure, and any other time you 
handle the capillary array, glass syringes, septa, or buffer reservoirs.

Name Volume Function

Array-fill syringe 250 µL High pressure syringe that displaces polymer into 
the capillary array

Polymer-reserve syringe 5 mL Stores polymer for multiple sequential runs

To clean a syringe: 

Step Action

1 Remove the syringe guard.

2 Remove the syringes as described on page 4-25.

3 Clean the syringe thoroughly by rinsing the inside and outside of the syringe barrel 
and the syringe tip with warm water.

IMPORTANT Be sure there is no dried polymer left in the syringes.

4 Rinse the syringe barrel and tip with deionized water.

5 Blow dry with compressed air.

6 Reassemble the syringe and then inspect it as described below.
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Inspecting a Syringe IMPORTANT After cleaning a syringe, always inspect it for missing O-rings to avoid leaks 
during your run.

To inspect the syringe:

Step Action

1 Inspect the syringe for two O-rings (P/N 221102): one behind the ferrule and one 
around the ferrule.

2 Verify that the ferrule is firmly seated in the end of the syringe.

0.05 0.1 0.15 0.2 0.25
GR2147

O-rings

Ferrule
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Priming and Filling Syringes

Priming and Filling
the Polymer-Reserve

Syringe

Follow this procedure after cleaning the polymer-reserve syringe or before the 
polymer in the syringe is 1 week old.

CHEMICAL HAZARD. POP polymer may cause eye, skin, and respiratory 
tract irritation. Please read the MSDS, and follow the handling instructions. Wear appropriate 
protective eyewear, clothing, and gloves. Use for research and development purposes only.

IMPORTANT Wear gloves while performing the following procedure, and any other time you 
handle the capillary array, glass syringes, septa, or buffer reservoirs.

Priming and Filling
the Array-Fill

Syringe

CHEMICAL HAZARD. POP polymer may cause eye, skin, and respiratory 
tract irritation. Please read the MSDS, and follow the handling instructions. Wear appropriate 
protective eyewear, clothing, and gloves. Use for research and development purposes only.

IMPORTANT Wear gloves while performing the following procedure, and any other time you 
handle the capillary array, glass syringes, septa, or buffer reservoirs.

To prepare the polymer-reserve syringe for use: 

Step Action

1 Draw approximately 0.3 mL of room-temperature polymer into a clean 
polymer-reserve syringe. 

2 Pull up the plunger to the 5-mL mark.

3 Invert the syringe about six times to coat the walls with polymer. Discard this 
polymer into aqueous waste.

Note Priming the syringe ensures that the running polymer is at the intended 
concentration and not diluted by residual water.

4 Fill the polymer-reserve syringe with a maximum of 4.5 mL of polymer. 

IMPORTANT Avoid introducing air bubbles into the polymer by keeping the 
syringe tip just submerged in the polymer while aspirating gently.

5 Remove any air bubbles by inverting the syringe and pushing a small amount of 
polymer out of the tip.

Note Do not return the unused portion of the polymer to the bottle.

CAUTION!

To prepare the array-fill syringe for use:

Step Action

1 Draw a small volume of room-temperature polymer into a clean array-fill syringe. 

2 Pull up the plunger to the 250-µL mark.

3 Invert the syringe about six times to coat the walls with polymer. Discard this 
polymer into aqueous waste.

Note Priming the syringe ensures that the running polymer is at the intended 
concentration and not diluted by residual water.

4 To prevent air bubbles, gently and slowly aspirate the polymer into the syringe until 
the desired volume has been reached.

5 Point the syringe up and slightly press the plunger to purge any air.

CAUTION!
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Installing and Removing Syringes

Installing Syringes

Removing Syringes

To install the syringes:

Step Action

1 Follow the procedures to remove, clean, and dry the upper polymer block starting 
on page 4-28. 

2 Place the polymer-reserve syringe tip in the left port on the top of the upper polymer 
block and screw the syringe tip clockwise into the polymer block. 

IMPORTANT Always hold the syringe by the metal sleeve—not the glass—when 
screwing the syringe into the block.

The syringe should be finger tight in the block.

3 Place the array-fill syringe tip in the right port on the top of the upper polymer block 
and screw the syringe tip clockwise into the polymer block. 

IMPORTANT Always hold the syringe by the metal sleeve—not the glass—when 
screwing the syringe into the block.

The syringe should be finger tight in the block.

4 Push the polymer block all the way against the instrument.

5 Replace the syringe guard.

To remove the syringes from the instrument:

Step Action

1 Remove the syringe guard.

2 Grasp the polymer-reserve syringe just above the fitting or at the base (not the 
glass barrel) and rotate the syringe counterclockwise.

IMPORTANT Be careful not to remove the fitting. There are several rings and 
check valves that could come out if this fitting is removed.

3 Grasp the array-fill syringe and rotate the syringe counterclockwise.

4 Dispose of any remaining polymer properly.

Do not loosen this fitting 
while removing the syringe.
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Section: Polymer Blocks

In This Section The following topics are covered in this section:

Topic See Page

Removing the Polymer Blocks 4-28

Cleaning the Polymer Blocks 4-29

Removing Air Bubbles from the Upper Polymer Block 4-32
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Removing the Polymer Blocks

Removing the Upper
Polymer Block

Removing the Lower
Polymer Block

To remove the upper polymer block:

Step Action

1 Remove the syringe guard.

2 Remove the syringes as described on page 4-25.

3 Disconnect the capillary array from the polymer block:

a. Press the Tray button.

b. Open the instrument, oven, and detection block doors.

c. Loosen the capillary array nut.

d. Pull out the polymer block part way.

e. Remove the detection cell from the detection block. 

f. Remove the capillary array sleeve from the polymer block.

g. If the capillary array is to be reused, store it as described on page 4-18.

4 Disconnect the polymer block tube from the lower polymer.

5 Grasp the upper polymer block with two hands and pull it straight out.

6 The upper polymer block rides on two steel shafts and slides out easily after a 
spring moves past a check point.

To remove the lower polymer block:

Step Action

1 Remove the anode reservoir and dispose of the buffer properly.

2 Grasp the lower polymer block and pull it straight out.
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Cleaning the Polymer Blocks

Frequency Clean the upper and lower polymer blocks:

♦ Before replacing the polymer on the instrument

♦ When the polymer has been on the instrument for longer than 1 week

Note Polymer older than 1 week may cause a transient increase in current during 
electrophoresis due to urea decomposition. 

Cleaning the Upper
Polymer Block

IMPORTANT Do not expose the polymer blocks to any organic solvents.

Below is a picture of the upper polymer block with the syringe and syringe adaptor 
attached.

GR2190

20-mL silicone-free syringe

6-mm syringe adaptor

Check valve

Upper polymer block

Polymer block tubing

To clean the upper polymer block: 

Step Action

1 Rinse all the fittings with hot deionized water. Soak any fittings that are covered 
with polymer.

IMPORTANT Do not use boiling water to rinse the fittings or the polymer block.

2 Hold the upper polymer block under hot deionized water.

3 Fit the 6-mm syringe adaptor (P/N 4322928) onto the 20-mL silicone-free syringe 
(P/N 4324463).

4 Thread the 6-mm syringe adaptor into the stainless-steel check valve.

5 Force several syringe loads of hot deionized water through each channel in turn by 
sealing their openings with your fingers. 

Note Force deionized water through polymer block tubing also.
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Cleaning the Lower
Polymer Blocks

Below is a picture of the lower polymer block with the syringe and syringe adaptor 
attached.

6 Inspect the channels visually for dried polymer, which is white residue. Wash 
partially occluded channels with hot deionized water until the dried polymer is gone.

IMPORTANT It may take a long time for the hot water to clear the obstruction. Do 
not use a sharp pointed instrument to clear the channel, even if the channel is 
completely occluded with dried polymer.

7 Rinse the upper polymer block and all the fittings thoroughly using deionized water.

8 a. Remove any residual water from the upper polymer block and fittings to ensure 
that fresh polymer is not diluted. This can be done by forcing air through the 
channels using the silicone-free syringe or by using canned compressed air. 

b. Force the air through the channels until the channels are dry.

IMPORTANT When using canned compressed air, be careful not to blow 
propellent from the can into the block. Do not shake or invert the can. Some 
propellants may increase background fluorescence.

IMPORTANT Do not use the 5.0-mL glass syringe to force air through the 
channels. This will damage the syringe’s plunger and cause the syringe to leak.

To clean the upper polymer block: (continued)

Step Action

To clean the lower polymer block: 

Step Action

1 Verify that the buffer valve is open (in the up position).

2 Remove the polymer block tubing and fitting from the upper polymer block, if this 
was not done before.

3 Remove the lower polymer block from the instrument.

4 Rinse all the fittings with hot deionized water. Soak any fittings that are covered 
with polymer.

IMPORTANT Do not use boiling water to rinse the fittings or the polymer block.

GR2191

20-mL silicone-free syringe

6-mm syringe adaptor

Buffer valve

Lower polymer block
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5 Hold the lower polymer block under hot deionized water. Using your fingers, move 
the buffer valve in and out to ensure any encrusted polymer is cleaned out of its 
guide channel.

IMPORTANT Do not remove any of the components from the lower polymer 
block.

6 Fit the 6-mm syringe adaptor (P/N 4322928) onto the 20-mL silicone-free syringe 
(P/N 4324463).

7 Thread the 6-mm syringe adaptor into the polymer block where the polymer block 
tube fitting was originally located.

8 Force several syringe loads of hot deionized water through the channel. 

9 Inspect the channels visually for dried polymer, which is white residue. Wash 
partially occluded channels with hot deionized water until the dried polymer is 
gone.

IMPORTANT It may take a long time for the hot water to clear the obstruction. 
Do not use a sharp pointed instrument to clear the channel, even if the channel is 
completely occluded with dried polymer.

10 Rinse the lower polymer block and all the fittings thoroughly using deionized 
water.

11 a. Remove any residual water from the lower polymer block and fittings to ensure 
that fresh polymer is not diluted. This can be done by forcing air through the 
channels using the silicone-free syringe or by using canned compressed air.

b. Force the air through the channels until the channels are dry.

IMPORTANT When using canned compressed air, be careful not to blow 
propellent from the can into the block. Do not shake or invert the can. Some 
propellants may increase background fluorescence.

IMPORTANT Do not use the 5.0-mL glass syringe to force air through the 
channels. This will damage the syringe’s plunger and cause the syringe to leak.

To clean the lower polymer block: (continued)

Step Action
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Removing Air Bubbles from the Upper Polymer Block

Clearing Air Bubbles To clear air bubbles from the upper polymer block: 

Step Action

1 Push down on the polymer-reserve syringe to move bubbles through to the lower 
right of the block. Push slowly (or tap) to minimize the amount of polymer used.

2 Push down slowly on the array-fill syringe to move bubbles down the channel. The 
bubbles will collect where the channels join.

3 a. Hold down the anode buffer pin valve and simultaneously push down on the 
array-fill syringe to build pressure in the channels.

b. Release the buffer pin valve (while still pressing down on the array-fill syringe) to 
expel bubbles into the polymer block tube.

4 Repeat step 3 as necessary.

IMPORTANT Verify that all air bubbles are pushed out of the tubing assembly into 
the lower buffer reservoir before proceeding. There should be no bubbles in the 
tubing or channel of the lower polymer block.

Polymer block tube

Bubbles collect here
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Section: Autosampler Calibration

When to Calibrate
the Autosampler

Calibrate the autosampler only as needed.

Symptoms of autosampler alignment problems may include:

♦ Poor injection for a small number of capillaries

♦ Low signal strength

♦ No evidence of sample

Calibrating the
Autosampler

To calibrate the autosampler:

Step Action

1 Select Tools > Calibrate Autosampler.

The wizard opens.

2 Follow the directions given in the wizard to calibrate the autosampler.
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Section: Checking the Available Space and Deleting Records

In This Section The following topics are covered in this section:

Overview The sections that follow tell you: 

♦ How to check the available hard disk space on drive D for the extracted sample 
files

♦ How to check the available space in the instrument database on drive E for the 
raw data

Topic See Page

Checking the Available Hard Drive Space 4-36

Archiving Data 4-37

Checking the Available Database Space 4-39

Deleting Records from the Database 4-39
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Checking the Available Hard Drive Space

Checking Hard Disk
Space

To check the hard disk for space for sample files: 

Step Action

1 Double-click the My Computer icon in the desktop to view the drives.

2 Right-click in the drive D and select Properties.

The Properties dialog box opens displaying the used and free space.
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Archiving Data

Creating a Data CD A basic version of Roxio Easy CD Creator™ 5 software was loaded on your Dell™ 
computer. Use this software to archive data to a CD. The software is also part of the 
CD set you received with your Dell computer.

3 Estimate how much free space you need by using the information provided below. 

4 If there is insufficient space:

♦ Archive the sample files to a CD-RW or another volume.

♦ Delete the original files from the drive.

To check the hard disk for space for sample files: (continued)

Step Action

File Type
Approximate Space 

Required Per File (kB)a

a. The values provided are estimates only. The actual file size depends on the run 
module selected.

Analyzed sample file for DNA sequencing 250

Analyzed sample file for fragment analysis 500

Unanalyzed sample file 100

To archive data: 

Step Action

1 Select Start > Programs > Roxio Easy CD Creator 5 > Applications > Easy CD Creator.

The Untitled - Easy CD Creator dialog box opens.

2  For help creating a data CD, select Help > Contents and Index.
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Installing a SCSI
Storage Device

We do not recommend that you add an SCSI storage device to the computer 
workstation. However, if you need to temporarily install one, follow the procedure 
below.

IMPORTANT Do not install a SCSI device on the computer workstation before the 3100-Avant 
Genetic Analyzer has been installed with the 3100-Avant Data Collection software. Installing a 
SCSI device first will alter the drive letter assignments so that the instrument and software 
cannot be properly installed.

3 In the left tree pane, select Making Data CDs for Archiving and Sharing > Making a 
Data CD.

Use the instruction to create the CD.

To archive data: (continued)

Step Action

To install a SCSI storage device:

Step Action

1 Shut down the computer workstation.

2 Plug the device into the external SCSI port.

3 Turn the computer workstation back on.

4 Ensure the drive letter assignments have not changed.
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Checking the Available Database Space

Automatic Checking
of the Database

Before a run or batch of runs, the data collection software will automatically check the 
available space to ensure sufficient space to store the data you will create. 

If the database does not contain enough space (~75% full), then use the cleanup DB 
utility to remove data and plate records.

Deleting Records from the Database 

Deleting Processed
Frame Data

The Cleanup Database utility deletes all run data and plate records in the 
database. Before running the utility, be sure that all runs have been extracted from the 
database.

Note There is no need to reimport the spatial, spectral, and run calibration methods or the 
calibration data obtained from the last calibration runs.

To delete processed frame data using the Cleanup Database utility:

Step Action

1 Ensure OrbixWeb Daemon is running.

2 Quit the 3100-Avant Data Collection software.

3 Using Windows NT Explorer, navigate to the following directory:

D:\AppliedBio\3100-Avant\Bin

4 Locate and double-click CleanUpDB.bat. 

This runs the Cleanup Database utility, which takes a few seconds to complete.

5 Shut down and then relaunch OrbixWeb Daemon.

If you do not perform this step, any new run data will not be saved 
to the database.

CAUTION!

CAUTION!
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A
Technical Support A
Services and Support

Applied Biosystems
Web Site

A services and support page is available on the Applied Biosystems Web site. To 
access this, go to:

http://www.appliedbiosystems.com

and click the link for services and support.

At the services and support page, you can:

♦ Search through frequently asked questions (FAQs)

♦ Submit a question directly to Technical Support

♦ Order Applied Biosystems user documents, MSDSs, certificates of analysis, and 
other related documents

♦ Download PDF documents

♦ Obtain information about customer training

♦ Download software updates and patches

In addition, the services and support page provides worldwide telephone and fax 
numbers to contact Applied Biosystems Technical Support and Sales facilities.
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B
Limited Warranty 
Statement B
Applied Biosystems
Limited Warranty

Statement

Applied Biosystems warrants to the customer that, for a period ending on the earlier of 
one year from the completion of installation or fifteen (15) months from the date of 
shipment to the customer (the “Warranty Period”), the ABI PRISM® 3100-Avant Genetic 
Analyzer purchased by the customer (the “Instrument”) will be free from defects in 
material and workmanship, and will perform in accordance with the published 
performance specifications contained in the 3100-Avant Genetic Analyzer 
Specification Sheet (the “Specifications”) publication number 106SP04-01.

During the Warranty Period, if the Instrument's hardware becomes damaged or 
contaminated or if the Instrument otherwise fails to meet the Specifications, Applied 
Biosystems will repair or replace the Instrument so that it meets the Specifications, at 
Applied Biosystems expense. However, if the 3100-Avant Genetic Analyzer becomes 
damaged or contaminated, or if the chemical performance of the Instrument otherwise 
deteriorates due to solvents and/or reagents other than those supplied or expressly 
recommended by Applied Biosystems, Applied Biosystems will return the Instrument 
to Specification at the customer's request and at the customer's expense. After this 
service is performed, coverage of the parts repaired or replaced will be restored 
thereafter for the remainder of the original Warranty Period.

This Warranty does not extend to any Instrument or part which has been (a) the 
subject of an accident, misuse, or neglect (including but not limited to failure to follow 
the recommended maintenance procedures), (b) modified or repaired by a party other 
than Applied Biosystems, or (c) used in a manner not in accordance with the 
instructions contained in the Instrument User Guide. This Warranty does not cover the 
customer-installable accessories or customer-installable consumable parts for the 
Instrument that are listed in the Instrument User Reference Guide. Those items are 
covered by their own warranties.

Applied Biosystems obligation under this Warranty is limited to repairs or 
replacements that Applied Biosystems deems necessary to correct those failures of 
the Instrument to meet the Specifications of which Applied Biosystems is notified prior 
to expiration of the Warranty Period. All repairs and replacements under this Warranty 
will be performed by Applied Biosystems on site at the Customer's location at Applied 
Biosystems sole expense.

No agent, employee, or representative of Applied Biosystems has any authority to 
bind Applied Biosystems to any affirmation, representation, or warranty concerning 
the Instrument that is not contained in Applied Biosystems printed product literature or 
this Warranty Statement. Any such affirmation, representation, or warranty made by 
any agent, employee, or representative of Applied Biosystems will not be binding on 
Applied Biosystems.
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Applied Biosystems shall not be liable for any incidental, special, or consequential 
loss, damage, or expense directly or indirectly arising from the purchase or use of the 
Instrument. Applied Biosystems makes no warranty whatsoever with regard to 
products or parts furnished by third parties. 

This warranty is limited to the initial purchaser and is not transferable.

THIS WARRANTY IS THE SOLE AND EXCLUSIVE WARRANTY AS TO THE 
INSTRUMENT AND IS IN LIEU OF ANY OTHER EXPRESS OR IMPLIED 
WARRANTIES, INCLUDING, WITHOUT LIMITATION, ANY IMPLIED WARRANTY OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE AND IS IN LIEU 
OF ANY OTHER OBLIGATION ON THE PART OF APPLIED BIOSYSTEMS.
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A
Activating a Previous Spectral Calibration 3-31
AEServer, starting 2-10
air bubbles, clearing 4-32
alignment, capillary 4-18
analysis module

selecting for fragment analysis 2-33
selecting for sequencing 2-39

analyzing fragment analysis data 2-74
Array View page, discussed 2-65
array-fill syringe

volume and function 4-22
See also syringe

Autoanalysis. See preferences 2-13
autoextraction failure 2-70
autosampler 2-20

calibrating 4-33
placing plates 2-46

B
buffer

discussed 2-19
hazards 2-26
making and storing 4-10

C
calibration 2-22
capillary

alignment 4-18
status 2-66

capillary array
checking alignment of capillaries 4-18
installing and removing 4-14
maintenance 4-13 to 4-19
selecting the length 2-17
storing off the instrument 4-19

Capillary View page, discussed 2-67
cleaning instrument, routine 4-5
computer

checking hard drive space 4-36
start up and log on 2-8

customer support. See technical support A-1

D
data

deleting 4-39
recovering 2-70
spatial calibration 3-4
viewing analyzed sequencing data 2-74
viewing raw data 2-71

data collection software, starting 2-10

database
capacity warning 2-55
deleting records 4-39

detection cell, cleaning 4-14
Display Run Data command 2-71
documentation 1-3
dye sets

selecting for fragment analysis 2-31
selecting for sequencing 2-36

E
extractor utility 2-70

F
Fill Down command 2-30, 2-38
fluorescence display 2-66
fragment analysis

analysis modules, selecting 2-33
data analysis 2-74
dye sets 2-31
polymer to use 2-18
run modules 2-32
run times 2-56

G
gel block. See polymer block

H
hard drive space

automatic checking 2-55
manually checking 4-36

I
injection pattern

384-well plate 2-50
96-well plate 2-49

instrument
cleaning, routine 4-5
documents 1-3
moving and leveling 4-6
operation 2-53
resetting 4-7
setup 2-15
shutdown 4-8
startup 2-9
waste warning 4-11

Instrument Status Monitor, discussed 2-68

L
limited warranty B-1
linking a plate 2-47
.log (spatial calibration log) files 3-4
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M
maintenance task lists 4-4
manual set 1-3
matrix standards

preparing for DNA sequencing 3-16
preparing for fragment analysis 3-17

mobility files, selecting 2-37
moving the instrument 4-6

O
OrbixWeb Daemon, starting 2-10
overriding

spatial calibration file 3-10
spectral calibration profiles 3-33

P
password 2-8
pausing a run 2-57
plate records

creating for GeneScan 2-29 to 2-34
creating for sequencing 2-35 to 2-40
discussed 2-28
linking and unlinking 2-47
reusing 2-41

Plate View tab 2-29, 2-35, 2-41, 2-47, 2-50
plates

linking and unlinking from plate records 2-47 to 2-48
placing onto autosampler 2-46
unlinking from plate records 2-48

polymer
adding and changing 4-10
selecting 2-18
when to add or change 2-18

polymer blocks
air bubbles 4-32
cleaning 4-29
removing 4-28

polymer-reserve syringe
volume and function 4-22
See also syringe

preferences, setting 2-12
Project Name field (in plate record) 2-30, 2-38

R
raw data, viewing 2-71
records, deleting 4-39
removing air bubbles 4-32
reservoirs

filling 2-19
positions on the autosampler 2-20

resetting the instrument 4-7
run

length of time 2-56
monitoring, discussed 2-61 to 2-68
planning 2-5
scheduling 2-49
settings 2-63

starting 2-54
starting, stopping, skipping, pausing 2-57
status 2-68
summary 2-4
viewing run schedule 2-62

run modules
selecting for fragment analysis 2-32
selecting for sequencing 2-38

Run View page, discussed 2-62
running buffer, making and storing 2-19

S
safety

hazard warnings 1-4
ordering MSDSs 1-6

sample
preparation 2-26
run order 2-49

SCSI device, installing 4-38
“Select the run to display” dialog box 2-71
sequencing

analysis modules, selecting 2-39
dye set 2-36
matrix standards 3-16
mobility files 2-37
polymer to use 2-18
run modules 2-38
run times 2-56
viewing analyzed data 2-74

shut down 4-8
software

setting preferences 2-12
setup 2-27 to 2-48

spatial calibration
discussed 3-3 to 3-11
displaying 3-9
evaluating the data 3-7
failed 3-8
log files 3-4
overriding 3-10
performing 3-5
when required 2-6, 2-22

spatial maps 3-4
spectral calibration

activating a previous calibration 3-31
displaying a profile 3-27
failure 3-26
G5vb module 3-29
overriding profiles 3-33
performing using default parameters 3-19
preparing matrix standards for DNA sequencing 3-16
preparing matrix standards for fragment analysis 3-17
run times 3-25
when required 2-6, 2-22
Index-ii



starting
AEServer 2-10
data collection software 2-10
instrument 2-9
OrbixWeb Daemon 2-10
run 2-57
spectral calibration run 3-24

status lights
on instrument startup 2-9

Status View page, discussed 2-63
stopping a run 2-57
syringe

installing and removing 4-25
maintenance 4-21 to 4-25
priming and filling 4-24

T
technical support A-1
toolbar 2-57
total intensity graph 2-67

U
unlinking a plate record 2-48
Update Capillary Array Info utility 2-17
user documents 1-3
user name 2-8
utility

Extractor 2-70
Update Capillary Array Info 2-17

W
warranty B-1
waste 4-11
wizards

Autosampler Calibration 4-33
Change Polymer 4-10
Install Capillary Array 4-15

Y
yellow capillary in Array View 3-26
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